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Preface
Welcome to mobile application development!

Developing apps can be fun and is potentially lucrative, but it is also quickly becoming a core
skill in the information technology field. Businesses are increasingly looking to mobile apps to
enhance their relationships with their customers and improve their internal processes. They
need individuals skilled in developing the mobile apps that support these initiatives.

This book is intended to be an introduction to mobile app development. After you successfully
complete the book, you will have the basic skills to develop both Android and iPhone/iPad
apps. The book takes you from the creation of an app through the publication of the app to
its intended audience on both platforms. We (the authors) have been teaching technology for
many years at the collegiate level and directly to professionals and strongly believe that the
only way to learn a technology is to use it. That is why the book is structured as a series of
tutorials that focus on building a complete app on both platforms.

Although the book is an introduction, it does cover many of the unique features of the mobile
platforms that make apps a technology offering new capabilities that businesses may use to
enrich or augment their operations. The features covered in the book include using the device’s
capability to determine its location, using hardware sensors and device components in apps,
and mapping.

If you have suggestions, bug fixes, corrections, or anything else you’d like to contribute to a
future edition, please contact us at jhiversen@gmail.com or michael.eierman@gmail.com. We
appreciate any and all feedback that helps make this a better book.

—Jakob Iversen & Michael Fierman, September 2013

What You'll Need

You can begin learning mobile application development with very little investment. However,
you will need a few things. The following list covers the basics of what you need for Android
programming:

= Eclipse and the Android SDK—You can download the SDK from Google (http://
developer.android.com/sdk/index.html) as an Android Development Tools (ADT)
bundle that includes the Eclipse Integrated Development Environment (IDE), Android
development tools, Android SDK tools, Android platform tools, the latest Android SDK,
and an emulator. The ADT bundle is for Windows only. If you are going to develop on
the Mac, you will have to download Eclipse separately and use the preceding URL to
get the various other tools. If you have an existing Eclipse installation, you can use this
location to add the Android tools. Appendix A, “Installing Eclipse and Setup for Android
Development,” has more details on how to install the tools. If your existing Eclipse
installation is earlier than the Helios version, we recommend that you update your
installation to be perfectly in sync with this book. If you cannot upgrade, you should
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still be able to work the tutorials. Some of the menu commands may be slightly different
and some of the windows may have minor differences, but you should still be able to
complete the tutorials.

= An Android device—This is not necessary for purely learning, but if you plan to release
your apps to the public, you really should test them on at least one device. The more
types of devices, the better—Android on different manufacturers’ devices can sometimes
behave in different manners.

= Familiarity with Java—Android apps are programmed using the Java programming
language. You should be able to program in Java. At a minimum you should have
programming in some object-based programming language such as C# or C++ so that
you can more easily pick up Java.

The following list covers the basics of what you need for iPhone/iPad programming:

= A Mac running Mac OS X Lion (v 10.8 at a minimum)—iPhone/iPad programming can
be done only on a Mac. That Mac should have a fair amount of disk space available and
a significant amount of RAM so you don’t have to spend as much time waiting for things
to compile and execute.

= Xcode 5—Xcode is an IDE provided by Apple available from Apple’s iOS Dev Center
(http://developer.apple.com/ios). Xcode S is free, but you can only run the apps you
develop on the simulator provided with Xcode. If you want to distribute your apps, you
must sign up as a registered developer (§99/year for individuals, $299/year for corporate
developers). If you are a teacher at the university level, your university can sign up for
the University Program (http://developer.apple.com/support/iphone/university). This
will allow you and your students to test apps on actual devices but does not allow public
distribution of the apps you create. If you are a student at a university, check with the
computer science or information systems department to see if they have signed up for
this program.

= An iOS device—As with Android, this is not necessary for learning how to program
an iOS app, but it is important for testing apps that you want to release to the public.
Additionally, some features of iOS programming cannot be tested on the simulator.
Appendix B, “Installing Xcode and Registering Physical Devices” has more details both
on installing Xcode and the work needed to be able to test your apps on a physical iOS
device.

= Knowledge of Objective-C 2.0—iOS apps are programmed in Objective-C. Objective-C is
a language that extends the C programming language and is organized like the SmallTalk
object-oriented programming language. If you have previous experience with Java or C++
it will ease your transition to Objective-C. Appendix C, “Introduction to Objective-C,”
contains an introduction to Objective-C that will help you with that transition.
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What if | Can’t Upgrade My Lab Computers?

Xcode 5 requires OSX 10.8. If your existing Macs cannot be upgraded to 10.8 you should still
be able to use this book to learn iOS development. In that case use Xcode 4.6. The sample
code provided with this book will not work, but you should be able to develop your own working
code by working through the tutorials. Some of the menus and windows will be different, but
the tutorial will still work.

Your Roadmap to Android/iOS Development

This book is intended as an introduction to mobile development for both Android and iOS.
Although the book provides everything you need to know to begin creating apps on both
platforms, it is not intended to be a comprehensive work on the subject. The book assumes
programming knowledge. At a minimum you should have taken at least one college-level
course in the Java or C programming languages. Mobile development introduces issues and
concerns not associated with traditional development, but at its core requires the ability to
program. Experience with an IDE is a plus. This book will help you learn the Eclipse and Xcode
IDEs but if you have some understanding and experience prior to working through this book, it
will ease your learning curve.

As a beginner’s book, that should be enough to successfully work through the tutorials.
However, to truly master Android and iOS development there is no substitute for designing and
implementing your own app. For this you will likely need some reference books. Following is a
list of books we have found helpful in our app development efforts. Of course, if all else fails—
Google it! And then you’ll likely end up with the good folks at StackOverflow.com, which has
quickly become a trusted source for answers to programming questions.

= iOS Programming: The Big Nerd Ranch Guide, by Joe Conway & Aaron Hillegass (Big Nerd
Ranch, 2012)

= Programming iOS 6, by Matt Neuburg (O’Reilly, 2013)

» iPad Enterprise Application Development BluePrints: Design and Build Your Own Enterprise
Applications for the iPad, by Steven F. Daniel (Packt Publishing, 2012)

= Android Wireless Application Development, by Lauren Darcy & Shane Conder (Addison-
Wesley, 2011)

= Android Wireless Application Development Volume II: Advanced Topics, by Lauren Darcy &
Shane Conder (Addison-Wesley, 2012)

How This Book Is Organized

This book guides you through the development of mobile applications on both Android and
iOS. The book focuses on building a single, complete app on both platforms from beginning

to publication. The book is meant for the beginner but goes into enough depth that you could
move into developing your own apps upon completion of the book. The philosophy embedded
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in the book’s approach is that the best way to learn to develop is to develop! Although the
book begins with Android development, you could choose to begin with iOS without any
problem or setback in understanding. However, we do suggest that you read Chapter 2, “App
Design Issues and Considerations,” before beginning either platform. After that, you can choose
either Chapters 3-8 on Android or Chapters 9-14 on iOS. You could even switch back and
forth between the platforms, reading first the introduction to Android in Chapter 3, then the
introduction to iOS in Chapter 9, and then continue switching back and forth between the
platforms.

Here’s a brief look at the book’s contents:

= Part I, “Overview of Mobile App Development”

= Chapter 1, “Why Mobile Apps?”—Mobile apps are a potentially disruptive
technology—technology that changes the way business works. This chapter
explores the potential impact of mobile technology and discusses how apps can
and do change the way organizations do business.

= Chapter 2, “App Design Issues and Considerations”—Mobile technology has
different capabilities and limitations than more traditional computing platforms.
This chapter discusses many of the design issues associated with app development.

= Part II, “Developing the Android App”

= Chapter 3, “Using Eclipse for Android Development”—Eclipse is an open source
development environment commonly used for Android development. Chapter 3
shows how to use Eclipse to build a simple “Hello World” app. The chapter is your
first hands-on look at app development.

= Chapter 4, “Android Navigation and Interface Design”—The limited amount
of “real estate” on a mobile device typically requires multiple screens to build
a complete app. This chapter introduces how you program movement between
screens in Android. The chapter explores in depth on how a user interface is coded
in Android where the number of screen sizes that your app has to accommodate is
relatively large.

= Chapter 5, “Persistent Data in Android”—Business runs on data. An app has to
be able to make sure important data is preserved. This chapter explores two types
of data persistence methods in Android: the persistence of large and complex
data in a relational database using SQLite and simple data persistence through
SharedPreferences.

= Chapter 6, “Lists in Android: Navigation and Information Display”—Chapter 6
introduces a structure ubiquitous in mobile computing—the list. Lists display data
in a scrollable table format and can be used to “drill down” for more information
or to open new screens. This chapter explains how to implement a list in an
Android app.

Xvii
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Chapter 7, “Maps and Location in Android”—Displaying information on a
map can be a very effective way to communicate information to an app user. This
chapter examines implementing Google Maps in an app and also demonstrates
how to capture the device’s current location.

Chapter 8, “Access to Hardware and Sensors in Android”—Mobile devices

come equipped with a number of hardware features that can enhance an app’s
functionality. The code required to access and use these features is discussed in this
chapter.

= Part III, “Developing the iOS App”

Chapter 9, “Using Xcode for iOS Development”—Chapter 9 begins the book’s
discussion of i0S. Xcode is the development environment used to develop iPhone
and iPad apps. Xcode and iOS development is introduced by guiding you through
the implementation of a simple “Hello World” app.

Chapter 10, “iOS Navigation and Interface Design”—Just as in Android,
interface design and navigation between screens are important concepts to master
in mobile development. This chapter guides you through the development of a
Storyboard for app navigation and demonstrates how to use Xcode's Interface
Builder to implement a user interface.

Chapter 11, “Persistent Data in iOS”—Many of the same data persistence features
available in Android are also present in iOS. One primary difference is that the
database feature of iOS is implemented through a wrapper kit called Core Data.
Core Data enables the updating and querying of an underlying SQLite database.

Chapter 12, “Tables in iOS: Navigation and Information Display”—Tables in
iOS provide the same type of information presentation format as Lists in Android.
Tables display data in a scrollable table format and can be used to “drill down” for
more information or to open new screens. Chapter 12 describes how to implement
this very important mobile computing concept.

Chapter 13, “Maps and Location in i0OS”—Chapter 13 covers the implementation
of maps and capturing device location information on an iOS device. It is
analogous to the Android chapter on maps and location.

Chapter 14, “Access to Hardware and Sensors in iOS”—This chapter
demonstrates the techniques used to access hardware features of the device. It
covers many of the same sensors and hardware features covered in the Android
chapters on the topic.

= Part IV, “Business Issues”

Chapter 15, “Monetizing Apps”—One of the reasons many people consider
getting into mobile application development is to make money. Both Android and
Apple provide a marketplace for apps that has a wide reach. This chapter discusses
various approaches to making money from your apps and briefly discusses
organization of your app development business.
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= Chapter 16, “Publishing Apps”—After you have developed an app, you'll likely
want to make that app available to its intended audience. This chapter discusses
publishing apps on Google Play and the App Store, as well as distribution of
corporate apps that are not intended for the public at large.

= Appendixes

= Appendix A, “Installing Eclipse and Setup for Android Development”—This
appendix provides instruction on installing the Eclipse development environment
and how to set up Eclipse specifically for Android development.

= Appendix B, “Installing Xcode and Registering Physical Devices”—This
appendix provides instruction on installing iOS development environment, Xcode,
and describes how to register iOS devices so that they can be used to test your
apps.

= Appendix C, “Introduction to Objective-C”"—This appendix provides a brief
tutorial on the Objective-C language.

About the Sample Code

The sample code for this book is organized by chapter. Chapters 3 and 9 contain a single
“Hello World” app in Android and iOS, respectively. Chapters 4 through 8 build a complete
Android contact list app, and Chapters 10 through 14 build the same contact list app in iOS.
Each chapter folder contains the code for the completed app up to that point. For example,

at the end of Chapter 7 the code includes the code developed for chapters 4, 5, 6, and 7. The
exception to this single completed app per folder model is in chapters 7 and 13. These chapters
demonstrate several approaches to getting location information on the mobile device. Each
technique has a folder with the complete app that demonstrates the technique. If a book
chapter requires any image resources, you will find those images in the respective chapter.

Getting the Sample Code

You'll find the source code for this book at https://github.com/LearningMobile/BookApps on
the open-source GitHub hosting site. There you find a chapter-by-chapter collection of source
code that provides working examples of the material covered in this book.

You can download this book’s source code using the git version control system. The Github site
includes git clients for both Mac and Windows, as well as for Eclipse. Xcode already includes git
support.

Contacting the Authors

If you have any comments or questions about this book, please drop us an e-mail message at
jhiversen@gmail.com or michael.eierman@gmail.com.

XiX
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Wifi: yards

1
Why Mobile Apps?

Mobile, Mobile, Mobile! Mobile technology is certainly receiving a lot of attention in the IT world as
well as the general business world right now. It seems everyone is executing a mobile strategy, designing
a mobile app, or worrying about managing mobile devices. But why all the buzz? What makes mobile
so special that it garners this much attention? In this chapter you explore some of the key reasons
behind the hype. It really is not “much ado about nothing!”

Transformative Devices

For all the hype, there must be something that makes these devices important. There is! Mobile
devices add a host of new possibilities for business and personal software because they are truly
the first mobile computing platforms. Although laptops and netbooks are moveable, their Size
significantly impacts how easily they are transported. Very few people carry a laptop during
their every waking hour to every location they visit! However, if this were their only advantage,
mobile devices would not be causing such a stir. There is much more.

(One key feature of a mobile device is the|capability to be made aware of its current environ-

ment through BUIESHTNSENsors. Mobile devices have sensors designed to capture where they
are, where they’re going, and the environment around them. Sensors can identify their present

location to within a few meters and capture their current heading, orientation, and accelera-
tion. Additionally, they can recognize how close they are to another object through a proxim-

ity sensor. These devices also have the GapaBItyIORAPHUETTORMATON AbOUT ThE AmbIEnt)

Another important feature of a mobile device is the capability to communicate with other
computing devices through a variety of mechanisms. A laptop can communicate using JNESE
and BIRIGEGSEH. However, mobile devices also have these communication capabilities; they
can communicate via GellanSIgnaly and using NeanRcIICOMMUNICAtOMIINES). Wi-Fi is
not available in all situations, and its range is measured in yards, whereas cellular’s range is
measured in miles. Bluetooth may be too short range to be useful in many situations, but
too long in other situations. The range of communication using Bluetooth is measured in

Cellular: miles

Bluetooth:

feet

NFC: inches
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Chapter 1 Why Mobile Apps?

feet, whereas the range of NFC is measured in inches. If a device wants to communicate with
another device based on its proximity, broadcasting in inches may be preferable to broadcast-
ing and listening in feet.

In addition to these capabilities not present in other computing platforms, mobile devices

have most of the same features, such as being able to _ Some of
these features have enhanced usability because they are on a device that is easily moved. One
example of this is the camera. Although many laptops and desktops have cameras built in, their
usefulness is limited because they cannot easily be moved. Data input is also similar because a
user can use either a keyboard or speech to enter data or instruct the device to perform some
operation. Again, these features may be more useful because data can be entered at its source,
when it is produced, rather than after the fact when human memory errors can impact the

integrity of the data._Another similarity is that mobile devices also have_
Finally, mobile devices are also

computers.

Taken together, the added capabilities of mobile devices compared to traditional computing

platforms means that the
Dramatic change in technological capability

enables the reexamination of the assumptions that business processes and products are based

on! Organizations base the design of what they do and how they do it on available technology.

If technology changes, the assumptions about what can be done are no longer valid. This inval-
idation of previous assumptions is disruptive, and if existing organizations don’t re-examine

their products and processes, it is likely that their competitors and start-ups will.

Reaching Customers

Smartphone users almost always have their device within reach. Organizations want to be
ready when a potential customer is interested in a product or service. If customers have to wait

until they get home to their computers, or worse yet, go to an actual store to get information
about or purchase their product, it may be too late. Individuals may forget about what they
wanted, or worse yet, a competitor’s product may be available and the sale is permanently
lost. Additionally, smartphone adoption rate and sales have greatly outpaced PC sales in recent
years. In many homes, they may be the only way to access the Internet. Furthermore, tablet
sales are expected to surpass PC sales in the near future, and many consumers are choosing
tablets instead of a PC, rather than in addition to a PC. Companies that provide their service
over the Internet may be left behind in these situations if they do not have a mobile strategy.

In many cases a _ may be enough to hold or attract the
customer. HOWeVeE, to truly tie your organization to the customer, anapp i required. Many
organizations are pursuing FOHIAPPIOACAEs! Apps can provide a stronger link to your organiza-

tion because static data and the basic interface is always available on the device, reducing the
amount of data that needs to be transferred and providing quicker access than having to always
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Reaching Customers

download this information.

In these situations, customers could make a purchase when
they get the urge, and the transaction could be uploaded when the device gets a data connec-

tion. Havingtheapplalwaysiavailable/6rtHe/device may lead to your organization being one of
the [iTSHCHOICEVEINEICONSUMERSAMBEIBUNGNNO0A. A ditionally, the app’s consistent
interface may help the individual learn it so that working with your organization becomes
quicker and easier than working with others.

Having a mobile HppICHIAISOISUPPONDIANANOVAIIANAIWATGHESS . Some organizations
have developed apps that allow customers to [flteractvitItncIIbIaAndSHnIPOSItveNvays. For

example, Starbucks lets customers define favorite drinks and collect rewards within their app.
Axe has developed several games where the player has to collect Axe cans to earn points. Nestlé
has an app that promotes fitness, and Zyrtec gives asthma patients tools to keep track of symp-
toms and current pollen levels. Finally, Kimberly-Clark helps parents with potty training their
toddlers in the Pull-Ups Big Kid App (Figure 1.1). Although these apps could also be available
on a traditional computing platform, having them on a mobile app allows the customer to
access them quickly when they happen to think of it, even if they are standing in line or sittin
on a bus. This allows the company to have a positive interaction with a customer in more situ-
ations than only when the customer is sitting at a computer.

ﬁﬁﬁ?ﬁm-

Welcome to the
Big Kid Academy

Celebrate your child's graduation to Big Kid status with
games, tools, tips and advice - all in one amagzing app.

S8 o JRCARCASGRE:

Big Kid 3D Potty Photos Videos & Big Kid Geta Training T
Celebration Rewards b Songs Timer Disney Call & Articlel

Figure 1.1 Screen shot of Pull-Ups app from Kimberly-Clark Inc.
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Chapter 1 Why Mobile Apps?

The Good Old Days

Ever hear the phrase “Banker’s Hours”? Many years ago, banks had very limited customer
service times, and getting to the bank to perform your business required going at hours not par-
ticularly friendly to many people’s schedules. The technology of that time required that the bank
have time to complete transactions after the customer left. To have enough time in the day to
complete the work, they had to limit the amount of time they were available to the customer.
This phrase became pejorative because people thought that the customer service hours were
the only time that bankers worked and because the limited access frustrated customers.

However, with the advent of better technology, banks were able to expand their customer ser-
vice hours, and the Internet made interacting with your bank something you could do anytime,
anywhere. These days, a bank would not have much of a customer base if it did not provide
online access. Mobile devices expand this problem. With many customers using a smartphone
as their only Internet access, banks that don’t provide mobile-friendly access will begin to lose
customers to those that do—or never have a chance to gain that customer.

One area where mobile devices enable a strong potential for disruption of the assumptions
made about a business process is the payment industry, where a lot of companies are innovat-
ing to provide consumers and businesses the capability to make and receive payments. For
instance, Square provides small retailers a simple solution to accept credit cards via a mobile
device and even use an iPad as a cash register, complete with inventory and listing of all prod-
ucts in the store. Although customers may not be able to easily get a printed receipt, the capa-
bility to easily email receipts may be even better. PayPal also allows for sending money easily
to individuals. Although PayPal has this capability on a traditional computing platform, the
capability to do it on a mobile device enables the customer to get money quickly to someone,
wherever they may be.

e e device’s Tiardware And SONWATEICAPABIIIGES to provide the customer with capabilities
AT Ak YO PrOAUCH ANIEasyOPHOMIOREAEM) The device’s location could be used to guide

potential customers to a nearby store or even find a product within a store. The device camera
could be used to present your products that are similar to the product image capture. Captured
UPC codes could be used to provide product information and prices. NFC or Bluetooth could
be used to alert customers that they are near your product in the store. The potential is there.
An app provides the capability to realize that potential. For example, Amazon has an app that
the consumer can use to scan UPC codes to compare a competitor’s product to theirs.

Changing Business Process

One of the most exciting possibilities associated with mobile technology is the potential it
has to impact business processes. Processes are designed within the parameters of the available
technology. When technology drastically changes, new forms are enabled. When that tech-
nology is cheap, change is enabled in areas that may have previously seen limited impact of



Hamid


Hamid


Hamid


Hamid


Hamid


Hamid


Hamid


Hamid


Hamid


Hamid


Hamid


Hamid


Kristall

Kristall

Kristall

Kristall

Kristall


Changing Business Process

the technology. Businesses are paying significant attention to mobile because these qualities
suggest that the technology may have implications for strategic and tactical advantage, or, as

demonstrated with the banking app, become competitive necessities.

Several years ago, business process reengineering (BPR) received significant attention in the
business and academic worlds. The idea of reengineering was important because of what was
termed the “productivity paradox.” For years, organizations were investing a significant amount
of money in information technology without realizing corresponding significant increases in
productivity. Investigation found that a major contributor to this problem was that organiza-
tions were using the new technology simply to automate existing processes. Information tech-
nology was applied to portions of the existing process to make it faster or increase accuracy.
This approach produced improvements, (bttithéywere inciemental father than revolutions
(@iy: As businesses became more adept with the technology and the technology became more
capable, it was recognized that the full potential of the technology was not being realized, and
companies began rethinking entire processes to take advantage of the technology. Noteworthy
improvements in process measures were realized, and BPR was born.

Mobile technology is likely to follow a similar path in application to business processes.
However, that path could be traversed much more quickly because of the past experience of
applying technology to business processes. The excitement over mobile technology is evidence
that a more aggressive approach to reengineering processes may be truer than a simple automa-
tion approach.

Still, there is room for automation, especially in smaller businesses that may have found that
the cost, complexity, and nonmobile nature of traditional computing platforms made techno-

logical solutions to their business process infeasible. Bossy (Figure 1.2) is an example of this.
The app is designed for the dairy farmer. As the farmer attends his cows, with Bossy he has at
his fingertips a complete display of the actions that need to be taken on different animals in his
herd. This automates the process of tracking the animals on paper or on a desktop computer
with written notes used while attending the herd.

Fence Builder Pro (Figure 1.3) is an app designed to support the fence-building industry.
Although some big fence-building organizations exist, the majority of fence-building compa-
nies are much smaller, family owned businesses in which technology plays a very limited role.
Fence Builder Pro is designed to manage job scheduling and communication. Jobs performed
by these smaller organizations typically last on the order of hours, rather than days or weeks,
precluding the need for more traditional project management software. Additionally, a need
exists to quickly rearrange the schedule because of outside influences such as the weather,
material delivery errors, and interaction with external agencies. Because these externalities can
change quickly, and because of the short nature of jobs, there is a need to quickly communi-
cate the new schedule to the field crew. Fence Builder Pro is innovative for the industry because
the schedule is also loaded on the crew foreman’s device. When the company’s owner changes
the schedule, it is automatically communicated to the foreman.
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Making Money

These two apps represent innovation in business processes that could not have been done
without a mobile device. In contrast to consumer apps, these apps sell for much more money.

They represent a significant investment by the developer in analysis and design and are focused
on a much smaller market.

Large organizations can also benefit from process redesign based on mobile technology, and
many are creating mobile development teams to explore, design, and implement process solu-
tions. The focus for these companies is on internal processes, and they are large enough to
absorb the cost of creating apps to support their processes. These apps are generally not avail-
able to other companies via an app market, although some apps available to consumers hint
at the internal process changes. One such example is the insurance company apps that allow
customers to provide insurance claims.

Although this provides an added convenience to the consumer, the benefit is much larger to
the insurance company, because claims are reported electronically and with no people at the
insurance company involved in receiving and recording the claim. Claims can also potentially
contain much more accurate, rich, and timely information. For example, State Farm’s Pocket
Agent app lets their customers report an auto incident; they can include pictures taken with
the device camera, tag the report with GPS coordinates, and draw a sketch of the scene. It's not
hard to imagine that State Farm also has mobile apps for insurance agents and claims adjusters
that use the data entered into Pocket Agent, so the entire process can be changed to take the
mobile devices into account.

Making Money

A final reason that mobile is all the rage is that many enterprising individuals see the potential
to start businesses and make money. The Google Play Store and the Apple App Store provide
the app developer access to the market of app purchasers. The developer does not have to
worry about product distribution, returns, or payment collection. The store does all this and
conveniently deposits the proceeds into the developer’s bank account. Additionally, smart-
phone users automatically go to these stores to get new apps or browse for apps that might
interest them. One final and very big reason for the strong focus on app development is that
Google and Apple either support or provide the development environments needed to create
apps for their stores. Taken together, this creates significant potential for individuals or small
businesses to make money in the app market.

Apps make money for their producer through several approaches. _

- like other products. Consumers buy the app through the appropriate store and it is
theirs for use whenever they like. The more apps the developers sell, the more money they

make. —
Anytime a user clicks an ad, the developer makes money. Both Google and Apple

provide developers access to the code to display ads and a service to provide the ads and
track the clicks. In contrast to a paid app, the only time the developer gets paid is if an ad is

clicked (Apple’s ad service also pays per view of the ad, but the amount is significantly less
than a click). The amount of money generated by a single click is very small, so to make much
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Chapter 1 Why Mobile Apps?

money it is important to get a lot of users of the app. Afthird'@pproach tomaking money isito)

(providerfor EADDIDUIGNARES: With this model, the user gets the app for free but needs to make
a purchase to get additional features. For example, a developer might provide a game for free

but require a purchase for more advanced levels of the game. Another approach is subscrip-

tion based. The app provides functionality that requires access to the developer’s data or other
services. To use the service, users buy a monthly or annual subscription.

The combination of device capabilities, an accessible market, and a diverse and large number
of developers makes the app market exciting and innovative. Because the market for consumer
apps puts a significant focus on free or low-cost apps, the challenge for a developer is to create
a product that appeals to a lot of people. Fortunately, the capabilities of the mobile computing
platform enable the implementation of apps that can do things in a variety of domains that
could never be done before. Chapter 15, “Monetizing Apps,” has a more in-depth discussion of
how to make money from the apps you have created.

Innovation Using Device Capabilities

Figure 1.4 shows an app that takes advantage of device capabilities to provide a product not
previously available. This is a paid app called GoFishing! It uses the device’s capability to cap-
ture its location, connect to the Internet, and store data to allow fishermen to record their fish
the moment they catch them, including where they were, what the weather conditions were
like, and how the fish was caught. The app provides search and mapping capability so that the
fisherman can locate previously successful locations, methods, and conditions to use in future
efforts. This functionality is not possible without the mobile device’s sensors and Internet
access.

Summary

Mobile technology is receiving significant attention in the business and IT worlds. The tech-
nology represents a dramatic change in technological capacity that has enabled potential
economic advantage for those able to take advantage of it. Mobile technology is the basis of
innovations in reaching customers, and in redesigning business processes and software products
that lead to the creation of many small businesses.

Exercises

1. Find an app that uses device capabilities to provide a product that previously couldn’t
exist. Explain what makes this app important or innovative.

2. Find an app designed to support a business process. What is the business process? How
does the app propose to improve it?

3. Identify and explain a specific business process. How might this process be automated
with mobile technology? How might it be completely redesigned?
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2

App Design Issues and
Considerations

App development for mobile devices is, in many ways, similar to development for other platforms.
However, in other ways, development requires attention to items that are not even present in traditional
development. Mobile devices have operating systems that run apps differently than traditional programs
do, have access to environmental sensors that are not available in laptop and desktop computers, have
a limited power supply, and have a much smaller screen. This chapter provides an overview of the
design issues associated with these differences. The chapter also discusses differences between iOS and
Android devices that impact design. The chapter concludes with an introduction to the app that will be
developed to illustrate design and development for both platforms.

App Design

Designing for the specific device your app will run on is extremely important! Applications that
work well on a traditional computer may be complete disasters if ported to a mobile platform
without redesigning the logic to fit the device’s capabilities. Additionally, the capabilities of
the device enable you to design an application that can do different things than an application
on a traditional computer. Apps are cheap and easy to obtain. If yours doesn’t work well, there
is likely to be an acceptable alternative. A well-designed app can be a delight to use. A poorly
designed app will not be used for long, if at all. The operating system, device size, and mobility
all impact design and must be accounted for.

Operating System Design Issues

The primary technical difference between mobile device operating systems and operating
systems used on laptop and desktop computers is that the mobile operating system is not a true

multitasking system. On mobile devices, only one app can be active at a time.
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was running gets put in the background. It remains in the background until the user specifi-
_ If it remains in the background too long, or if available memory gets
too low, the operating system may Kill it. This back-and-forth between different states is called

the app’s life cycle. Both Android and iOS apps have a life cycle.

As [8€H interact with the device, they may or
When this happens the a oes through different states, requiring the

developer to handle this switch so that users don’t lose data or get unnecessarily interrupted in

the task they were performing. This makes understanding, and designing for, the app life cycle
extremely important to the successful app developer.

Android Life Cycle

To understand the Android life cycle it is useful to first understand the states that an Android
app user experiences. When users touch an app's icon, the app is started and becomes visible
(to the users. While the app is visible, the users can interact with it. This is considered the
Resumed or running state. As the users interact with the app, they may be interrupted with a
pop-up window, or they may be distracted and not touch the screen for a period of time. If

the users stop interacting for a period of time, fhe'app will'fade but still'be partially Visible! [n_
either of these two cases the app EiiféisithePaused state _
the app becomes fully visible again, and the a

If users turn on the screen or use the Back button to get back to the app, the app again enters

the Resumed state. (Alappican temain in the Stopped state for quite some time. However, if the

device is rebooted or a user runs a number of other apps before coming back to the original
app, that app can be Destroyed by the operating system to free up resources for other apps that

the user is actually interacting with. To design an app that functions well given this pattern of
use, developers must understand what happens as the app enters and leaves these states, as well
as what they should design the app to do in those instances. This requires understanding the
Android life cycle.

TheAndroid ife’eyele (see Figure 2.1) begins when a user touches an app’s icon. This action
causes the onCreate method in the app’s initial activity to execute. This method includes code

to load the screen (called a layout) associated with the initial activity to load. The developer
needs to place code in this method that initializes variables and layout objects to the settings
required for the user to begin interacting with the app.(After the activity has been created, the

(onStart method is executed: This method does not have to be implemented but is useful if the
app requires certain settings to be the same for every time the app starts, Whether it is an initial |

(but not destroyed) state. After the activity has started, the onResume method is executed.
This method also does not have to be implemented but is very useful to return the app to the

running state that the app was in before it paused. This includes
and any other

settings needed to allow users to pick up where they left off.
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App Design

¢

/ onCreate()

i
s

Created Destroyed
/ onSitart() / onDestroy()
Activity is visible / onStart(),onRestart()
but user cannot Started <€ Stopped
interact with it.
/ onResume() / onStop()
Activity is visible ¢ / onResume() Activity is visible
and user CAN —‘ Resumed ‘,: L Paused but user cannot
interact with it. A interact with it.

/ onPause()

Figure 2.1 Android life cycle.

When a user stops directly interacting with the a the path to destruction begins. None of
the methods executed on the path to destruction have to be implemented. However, they often
serve a useful purpose and should be considered. The first method executed is onPause. This
method should be used to stop services that the app is using, to stop animations, or to store
important state information so that users can start using the app exactly as they left it. If the
. This method should

make sure
Finally, if not restarted, the onbestroy method will be executed

iOS Life Cycle

The life cycle for iOS is similar to Android’s. However, iOS uses both an app life cycle and a
screen (called view) life cycle to accomplish essentially the same things. As with Android, the
life cycle (see Figure 2.2) begins when the user taps an app’s icon. The application:
didFinishLaunchingWithOptions: method is similar to an activity’s onCreate method.
However, in iOS this method is used to set up the operating environment for the complete app,
not just a single activity.

The applicationWillResignActive: method is executed when the app is interrupted, similar

to when the onPause method is executed in Android. Finally, when the_
Visibie theiappiiicationpiarntersackarounamethodusiexeauted. As with Android, code in

these methods should be used to turn off services and save important data for the user before
it’s potentially lost.

15
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16 Chapter 2 App Design Issues and Considerations

/ application:didFinishLaunchingWithOptions:

N
App is visible
and useable.

/ applicationWillResignActive:

D
App is no longer

visible or useable.

/ applicationDidEnterBackground:

Figure 2.2 i0S App life cycle.

Unlike Android, iOS has a separate life cycle for displayed screens (called viewControllers).
The view life cycle (see Figure 2.3) begins after the application has finished loading or the user
goes to a different page in the app. After the view is loaded into memory, the viewDidLoad:
method executes. This method is executed only once if the view stays in memory. You should
write code in this method to set the initial state of the view. After the view has loaded into
memory, just before the view is visible to the user, the viewWillAppear: method is executed.

Code in this method should be used to load any data into the views that will be visible to the
user and turn on services that the user needs to interact with the app. This method executes

every time the view reappears on the device.

é Unloaded

/ viewDidLoad: V|ewW|IIAppear / viewDidUnload:

View is visible : : . .
/ viewWillAppear:
and user can Running J<€ ep 1 Hidc@— V'S;’;’iéslemt

interact with it.
/ viewWillDisappear:

Figure 2.3 i0S View life cycle.

Just like in Android, if an app is interrupted, or the user doesn’t interact with the device for
a period of time, or the user moves to another view in the app, the view is pushed into the
background. Just before this happens, the viewWillDisappear: method is executed. Code in
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App Design

this method should turn off services and take steps to save the user’s data.

Understanding and properly coding the app to take advantage of the methods associated with
the life cycle are important to ensuring a good user experience with your app. Take the time
to understand these life cycles, and your app development experience will be significantly less
frustrating!

Screen Size and Orientation Issues

The most obvious difference between mobile and traditional application design is the amount

of real estate you have to work with. The mobile device has significantly less area to design the
interaction that your users can experience with your app. [Pooriinterface’designiis the easiest)
(Way to'getbad reviews for'yourapp: Mobile devices are also used in different situations than
traditional computing devices are. App users are often multitasking (walking, talking with
friends, and so on). The app design must allow users to switch to your app and do what they
(WantiteldoTightiaway before theyiareidistractediagain) If users can’t easily figure out how to
use the app, no amount of help will satisfy them. This is no different from traditional develop-
ment. However, the very limited screen real estate makes it a significant challenge. In addition,
the focus among app developers has been on very good user interface design, so the competi-
tion is fierce for apps that work really well.

In response to the limited screen size, both iOS and Android have the capability to scroll to

interface elements not on the screen. Scrolling can be both horizontal and vertical. However,

both scrolling capabilities should be used judiciously, especially horizontal scrolling. Scrolling
down a list has become a natural action on both traditional computers and mobile devices.

However, horizontal scrolling has not. Horizontal scrolling should be reserved for use for
elements that start on the main screen and extend off the screen. Users won’t naturally think
to horizontally scroll to look for items they can’t find on the main screen. Even vertical
scrolling should be limited. Lists are obvious choices for vertical scrolling, but other types of
interface elements should be limited. Additionally, when scrolling, you must also fix certain
elements so that the user can perform needed operations without scrolling back through the
entire contents of the screen.

(ourappy Screens should focus on one, or a very limited and coherent, set of tasks that the user
can or would want to do. Navigation should be planned and designed so that it is obvious to
the user how to proceed to the next task. If a task requires multiple steps, those steps should

be designed as distinct screens, and the user should be guided through the screens needed to
complete the whole task.

tion can change as the user turns the device also presents design issues. When the wser tums

the device from vertical to horizontal orientation, the layout or view reorganizes to that

17
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orientation. This significantly changes the amount of vertical and horizontal real estate for
your interface. Interface elements that were obvious to the user in the vertical orientation

may become inaccessible in the horizontal orientation. Again, this can be a very frustrating
experience for your user, (eSS you carerlly plan for thie layoutinbothionentations and)
(thoroughly testiitasiwell Scrolling can be implemented to alleviate some of the problems asso-
ciated with orientation change. (HOWeVEHSimplyadding SCrollingimay mousolve the userexpes
rience issues. If you cannot make it work in an alternative orientation, as a last resort you can |
code the app to work in only one orientation.

The solutions to these screen size and orientation issues are planning and design. What does.

the user want to do with your app? What can your user do with your app? What are the logical
steps needed to accomplish those tasks given the device limitations? These are the types of
questions you must answer to design a successful app.

Connectivity Issues

One of the most important aspects of mobile devices is that they are able to communicate with
other devices and the Internet. This enables the capability to create very powerful and useful
apps. However, this also poses design problems. The device’s capability to connect can be lost,
or the connection speed may be very slow. Additionally, these problems can arise if the device
moves even a few feet. Compounding the problem is that users may not recognize or even
understand that there is a connectivity problem while they are using your app. (Applefequires)

Again, design and planning are your solutions.

(Working with'your app) When the app gets or sends data, it can take a significant amount of
time. Users are unlikely to be happy waiting for this action to complete before doing other

tasks. This means you have to plan for uploading and downloading data asynchronously,

which means you have to make it run outside the main thread of the app. It also means that
the rest of the app should be designed to provide other things users can do unless the data is

absolutely necessary for the task. If a user tries to do something that requires the data, provide
a warning. The warning should provide enough information to help users decide what they
should do next. If there is no connection or if there is a weak signal, tell them and give them
options.

Users Can’t Wait!

In my first app, | (Michael) made this mistake. The app retrieved weather information as part
of its functionality. | included it on the main thread of the application. Everything worked fine in
testing because | was in an area with good connectivity. But the first time | used it in the field
where there were connectivity problems, | couldn’t use the app at alll | could see the screen,
but nothing worked because it was waiting for the weather. The screen eventually timed out,
and | retried starting the cycle again. This was very frustrating. If | had purchased the app, |
would have immediately demanded a refund.
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App Design

Uploading important data is also a concern. As with a download, uploads should be performed
asynchronously. You need to check that the upload was completed fully so that if a connection
is lost during the upload, the user’s data is not corrupted. This means that the data should be
cached locally until it is successfully uploaded. Finally, you may need to provide functionality
to upload the data when a good connection becomes available.

Communication problems external to the app can impact your app’s performance. You must
plan for this possibility to provide the best user experience possible.

Battery Issues

Mobile devices are just that—mobile. This means that they are not always connected to a
power source. They rely on batteries for their power, and batteries can be drained. Your job as a
developer is to not drain those batteries unnecessarily. This is not just a courtesy issue. If every
time your app is used the user’s device quickly becomes a brick, it will be noticed. An app that
quickly drains power will not get used, will get bad reviews, and eventually will not get down-
loaded at all.

RPN e AW OTeVICESISIEISPIAY You cannot do much about that except
to make sure that your code is efficient and doesn’t take an unnecessary amount of time to

complete the work that the user wants to do. Also, you should make sure that users can pick up
where they left off if the app is interrupted so the screen doesn’t need to be on so long.

(caera; CommuNICatON AN ther Sensors Are Al bg POWSHATAWS Fortunately, it is within

your power to control these things. You control access to device hardware within your app and
should turn on these capabilities only just before the user needs them. You should also turn

them off as soon as the user completes the task that requires these items.

The app’s life cycle plays an important role here. If the app is interrupted, all device access or
use should be suspended immediately. When the app is about to become active, turn on as late
as possible only those device capabilities needed. For example, in the previously mentioned app
that uses weather data, the weather retrieval is started as one app activity becomes active. If the
weather data is successtully retrieved, it is time stamped. The next time the activity becomes
active, the weather data will be retrieved only if it is outdated, thus saving battery power.

Some battery issues are beyond your control. You cannot make an app that extends battery
power. However, you can definitely make an app that significantly reduces battery life. Be sure
to plan for battery use when designing your app.

Hardware Issues

A very cool aspect of mobile computing is the set of hardware components available on the
device. Many devices have the capability to locate the device within a few meters using the
GPS, have sensors that can capture device orientation, have lights that can be turned on and
off, have cameras, and have other hardware components that allow the device to interact
with the environment. Access to these components can make fun and useful apps. However,
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Chapter 2 App Design Issues and Considerations

employing them within your app is not without potential problems. The battery issue was
discussed in the previous section, and this is always a concern when using hardware devices.
However, each component has its own set of issues that, when used poorly, can make an app
less desirable.

The first issue to be aware of is availability of the component. Different manufacturers make
Android devices, and some include devices that others do not. iOS devices are generally more
homogeneous, but differences still exist. Because of this, it is very important to consider how
important the component is to the primary functionality of your app. If it is only tangential,
you may want to consider not using it because using it will often prevent the app from be
loaded onto the device. At best, the absence of the hardware component on the usetr’s phone
or tablet will cause frustration with your app. Another concern is situational availability. For
example, for a device to get a GPS signal, the device has to have the capability to get the satel-
lite signal required for operation. If the user is indoors, the GPS may not work.

It's My Fault!

Early on in my app development efforts, | (Michael) created an app that uses GPS data to map
certain points. This app was made available in the Android Play Store, but to try to expand the
availability of the app, | submitted it to the Amazon App Store. Unlike Android, Amazon reviews
the apps submitted to them before they make them available. They rejected it because it didn’t
work! | couldn’t believe it. It always worked for me. However, they were testing it indoors where
it never got a GPS reading, and therefore nothing worked. My design didn’t account for this
possibility, and the entire functionality was dependent on getting a GPS reading. Realizing that
much of the app’s functionality did not require the GPS, | redesigned it to handle the situation,
and Amazon eventually accepted it. However, if this happened to a user, you may not get a sec-
ond chance—or worse, the user might write a scathing review of your app.

A second issue to be aware of is time delays. To access a hardware component you must use the
component’s Application Program Interface (API). The component may take some time to turn
on and respond with the information you need. If this delay is significant, it may impact the
user experience in such a way that your app is viewed negatively. For example, the GPS system
takes time to acquire enough satellite signals to accurately locate your device. This could take
more than a minute. Stopping app function until this happens should be avoided if possible.

If the user is left waiting for the device to respond, the screen may time out. This issue may be
encountered even if you did everything properly and turned off the services when the app is

about to be sent to the background, and then turned them on again when the user re-opens
the app. However, if the activation of the device takes time, your app will end up hanging

every time it returns from the background. This vicious circle will not please the user. The
proper solution to this particular problem is to use a separate execution thread to do the initial-
ization, thus allowing the user to interact with other parts of your app while the services are
being activated.

A final important issue with the use of hardware devices is accuracy. There are several aspects

of this issue. First, the accuracy of the component can differ among manufacturers. (Consider)
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Device Differences

Be sure to give the user options if the required level of accuracy is not available. Second, accu-
racy often takes time. For example, to find the location of the device within a few hundred
meters is often very quick. However, accuracy of a few feet often takes much more time. What
is the required level of accuracy for your app’s functionality? What can the user do if the device
cannot achieve this? How quick does the acquisition of location need to be? All are important

considerations when you are designing the app. (SNEIEO0MAESIETSHATEEyNWHETyOuTEed)
DR ACCACIS O KEep e Ser IONEdOPIORIESS The Google Maps app provides an

example of this. When finding your location on the map, the app first shows a big blue circle
that gets progressively smaller as the accuracy improves. Finally, how the device returns data to
the app may impact the level of accuracy your app can access. Again, using GPS as an example,
the number of digits reported for the latitude and longitude coordinates dictate the level of
accuracy of those coordinates. In some cases, the number of digits reported can differ. This is
primarily an issue for the Android platform because it can differ among versions of the
Android OS.

Device Differences

Android devices (phones and tablets) and iOS phones and tablets each have a unique set of
hardware and software capabilities that make the way the user interacts with the device differ-

ent for each. Again, to fully capture the device’s capabilities and not degrade the user experi-

ence, you must design for those unique characteristics. Remember, users can and will do things
you are not expecting. Even if it makes no sense to you, they will do it! If the app crashes or

loses important data because of something they did, it does not matter: IT IS YOUR FAULT!
Plan accordingly.

It's Your Fault!

| (Michael) have an app that uses GPS data to map certain points. Against my better judgment,
| was asked to allow the manual entry of GPS coordinates for the app. One user contacted me
about why his app was always crashing when he tried to display the map. We went back and
forth on potential fixes. (He really liked the app and wanted to use it. Most users would just
delete your app). | could not figure it out, so | finally asked him to send me his data. He wasn’t
entering GPS coordinates! He just entered information about the location. | assumed that my
users would know to enter the exact GPS coordinates, not just the location name without

exact coordinates. | had to add an error message to the manual location entry to handle the
situation. You never know what a user is going to do!

Android

Android devices originally used four hardware buttons (see Figure 2.4) to support the user’s
use of the device. These buttons were the Home button, the Menu button, the Search button,
and the Back button. The user could press any of these buttons at any time during use of your

app, which would impact the functioning of your app. The Home and Back buttons worked
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independently of your code, whereas the Menu and Search buttons provided functionality only
if your app was specifically coded to use these buttons.

=l > D Q
Figure 2.4  Android hardware buttons.

However, more recent Android devices (running Android 3.0, API 11 and greater) have replaced
these buttons with virtual buttons at the bottom of the screen and an action bar at the top of
the screen (Figures 2.5 and 2.6, respectively). The Back and Home virtual buttons remain the
same in both form and function. However, the Menu and Search buttons were eliminated, and
a Recents virtual button was added. The Recents button shows the user’s recently used apps.
The action bar displays the app’s icon and title and the menu. Menu items will be displayed
with an icon (if defined). If there are too many menu items to be displayed with an icon, the
extra menu items are accessible through the three vertical dots on the right side of the menu
bar. If an app is targeting older versions of Android as well as newer, the action bar presents
only the three dots at the far right. When pressed, these dots perform the same function as the
Menu button.

Figure 2.6  Android action bar.

The Home button immediately moves your app to the Stopped state. This causes the onPause
and onStop methods to execute. It will not destroy the app unless it needs the system
resources. This means you must pay attention to these events even though you may not be
anticipating this behavior when your app is in use.

The Back button immediately goes back one action or activity: This can have several impli-
cations for your code. For example, if the user is looking at an activity and presses the Back
button, the visible activity will be immediately moved to the Stopped state (causing the
onPause and onsStop methods to execute). It will move the previous activity into the Running
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Introducing Your First App

state. This will cause the onStart and onResume methods to execute for that activity. If

your activity has displayed a pop-up, the activity is currently in the Paused state (because it

is partially visible). Pressing the Back button will hide the pop-up and cause the onResume
method to execute, and your activity will be placed in the running state. If the soft keyboard is
displayed, your app is also in the Paused state. Pressing the Back button will hide the keyboard
and again put your activity in the Running state.

If the user presses the Menu button, your app will not do anything unless you have specifically
programmed it to have a menu. Menus can be useful ways to provide the user with access to

functionality that is not used as the normal course of events in using your app; thus, you don’t
want to waste valuable screen real estate to provide access to that functionality.

Finally, the Search button also does nothing unless you code it. You can use this button to
allow the user to search for information within your app.

The hardware/virtual buttons provided by Android devices either have an impact on your app
or can be used to extend the functionality of your app. In either case it is important to plan for
the impact of these buttons when designing your app.

i0S

The primary hardware button of concern on iOS devices is the Home button. This button
immediately moves any app presently running to the background. The viewWillDisappear:,
applicationWillResignActive:, and applicationDidEnterBackground: methods will all
be called. Plan your app so that this action will not cause problems.

Both Android and iOS have a button that puts the device to sleep or reboots it. This action also
must be handled. Fortunately, the same methods that put the app in the background for other

actions are executed so, typically, no additional programming is required to prepare for this.

Introducing Your First App

To learn both Android and iOS design and development, you will build the same app on each
platform. Building the same app on both platforms is useful for understanding differences and
similarities between the platforms. The app you will build is called MyContactList. Building a
contact list app is a good way to learn mobile development for two reasons. First, its purpose
and function is generally understood, so a significant part of any application development
effort (understanding the functional requirements) does not need to be explained. Second, a
contact list app requires utilizing many basic and advanced features of mobile development;
therefore, it is very useful in providing a context for learning these concepts.

The MyContactList app consists of four different screens. Each screen is used to illustrate
basic app development concepts you will use in almost any subsequent app you develop.
Additionally, you'll learn how to navigate between screens in an app.
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Contact Screen

The contact screen shown in Figure 2.7 is used to enter, edit, and save information about
people in your contact list. While developing this screen, you learn some of the fundamen-
tal concepts of mobile user interface design and data entry. Later on, you use this screen as

a way to learn how to create and store data in a database on a mobile platform. Finally, the
contact screen shows you how to integrate hardware capabilities into an application by using
the device’s camera to capture a contact’s picture and to make a phone call by tapping the
contact’s phone number.

Carrier %

< Contacts

MyContactList

Contact: i @ '
John Robertson

Address:
33 Eveline St.

DN EEN [ o w o

Home Phone: Cell Phone:

Address:

Home Phone: Cell Phone:

‘ 920-555-1212 920-379-1212
Email Address:

ft@test.com

E-Mail Address:

Bithday: 3/26/78 Change

P § i i,

Contacts Map Settings

Figure 2.7 The Contact screen.

Contact List Screen

The contact list (see Figure 2.8) is used to search for basic contact information and allow selec-
tion of a contact for further action (for example, editing and deleting). Lists are very important
components of many apps on both Android and iOS. Developing this screen teaches you how



Introducing Your First App

to integrate them into any future app. This screen also demonstrates how to access information
provided by hardware components of the device.

i0S Simulator = Phone Retina (4=inch) [ i0S 7.0 (11A44000) |

@' I{J Carrier ¥ 413 PM 0
Contact List
|' I g7 + Contacts Edit
Delete Add Contact
_ _ = _ Fred Smith @
John Robertson o | chicese
920-555-1212 John Robertson @
Oshkosh
Robert Johnson <

920-555-1414

2 g =3

Contacts Map

Figure 2.8 The Contact List screen.

Map Screen

The map screen (see Figure 2.9) is used to display the recorded location of a single contact or
all your contacts on a map with a pin. The screen also demonstrates how to display the device’s
present location on the map and how to switch between different map views. The usefulness
and importance of maps on mobile devices needs no further explanation. Through the devel-
opment of this screen you learn how to integrate mapping into your apps. Additionally, the
screen will be used to demonstrate another approach to accessing sensor information.
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Figure 2.9 The Map screen.

Settings Screen

The Settings screen (see Figure 2.10) is used to set the sort order for the contacts in the Contact
List. In developing this screen, you learn to use a method of data persistence designed for captur-
ing and storing individual pieces of data. This type of data persistence is often used to capture
user preferences for an app. You also learn to use a different type of display widget (view).

Summary

App development is different from traditional software development. You must design to take
advantage of, and be aware of, the impact of the mobile operating system and the hardware

that the app is running on. If you do not design your app to account for these differences in the
device, you will ensure that your app does not get much use. Android and iOS devices have many
similarities and differences that require planning when you are developing an app that will run
on both device families. To learn both platforms and learn the differences between them, you will
develop the same app for both platforms in the next two sections of the book.
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Figure 2.10 The Settings screen.

Exercises

1. Find an app that runs on both platforms. Download and run it. Identify the similarities
and differences between the platforms.

2. Find out what uses the most battery power on the mobile device. On Android find the
battery usage information. This can be in different places on different Android devices
but is typically in the Settings app. Scroll through the list of power draws. What requires
the most? What requires the least? Note: This feature is not available on iOS.

3. Open an app that uses the GPS (for example, Google Maps). Look at the status bar at the
top of the device. What icons are there? What are they doing? Watch until the device
goes to black and then turn it on again. What changes occurred in the status icons? Now
switch to the home screen. What happened to the status icons?
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3

Using Eclipse for Android
Development

This chapter is an introduction to building a complete Android app. The chapter includes creating a
new app project, exploring the components of an Android app, setting up the emulator to run and test
apps, and building a variation of the traditional Hello World app. This and the following chapters in
this part assume that you have access to Eclipse and that it is set up for Android development. If this
is not the case, refer to Appendix A, “Installing Eclipse and Setup for Android Development” before
continuing.

Starting a New Project

Eclipse is a powerful, open source, integrated development environment (IDE) that facilitates
the creation of desktop, mobile, and web applications. Eclipse is a highly versatile and adapt-
able tool. Many types of applications and programming languages can be used by adding differ-
ent “ ."” For example, plug-ins are available for a very large number of programming
languages as diverse as COBOL, PHP, Java, Ruby, and C++, to name a few. Additionally, plug-
ins provide the capability to develop for different platforms, such as Android, Blackberry, and
Windows. Many of the tools in the Eclipse IDE will be explained through the act of developing
an Android app.

Android is a mobile operating system designed for smartphones and tablets. The operating

system is very powerful, enabling access to a diverse set of hardware resources on a smartphone
or tablet. Android is provided by Google and is continually updated, improved, and extended.
This makes the development of apps for Android smartphones and tablets both exciting and
challenging. As with Eclipse, the many features of the Android environment are best explained
through the act of developing an app.
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Chapter 3 Using Eclipse for Android Development

Setting Up the Workspace

Eclipse uses the concept of a workspace for organizing projects. Because Eclipse can be used to
develop many types of applications, this is very useful. A workspace, in reality, is just a folder
on some drive on your computer. The folder contains the application’s code and resources,
code libraries used by the application (or references to them), and metadata that is used to keep
track of environment information for the workspace.

To begin, run Eclipse. The Workspace Launcher dialog window opens, asking which workspace
you want to use. The default workspace (or last used) is displayed in the dialog window’s text
box. Most IDEs are designed with the idea that developers are going to be working on the same
machine each time they work on a project. This can cause problems in the education environ-
ment where students do not have the ability to work on the same machine and/or store their
work on the machine they are currently working on. If you are using your own machine, you
can skip to the next section; your workspace was created when you installed Eclipse and is
ready to go. However, if you are working in an environment where you cannot use the same
machine each time, you need to set up a workspace on either a flash drive or on a network
drive. Determine which of these options is best for your situation and perform the following
steps:

1. Create a folder in your selected location named workspace.
2. Go back to the Workspace Launcher and browse to your new folder. Click OK.

Often in a situation where you change the workspace to a location not on the machine
that Eclipse is installed on, Eclipse will not be able to find the Android SDK. If it cannot
find the SDK, a dialog window opens. If this happens, you will have to tell Eclipse where
the files are located by performing the next steps.

3. Click Open Preferences on the dialog window and browse to the sdk folder. This is
usually located in the .android folder. Click Apply.

The available Android versions should be displayed in the window.

4. Click OK to close the dialog window. Your workspace is now ready to begin Android
development.

Creating the Project

The traditional beginning tutorial for many different languages and development platforms

is “Hello World.” Your first Android app will be a slightly modified “Hello World” app. In
Eclipse, all Android apps are created within a project. To create your first app, you will have to
create your first project. Creating a new project requires stepping through a series of windows
and making choices to configure your app. To get started, from Eclipse’s main menu choose
File > New > Android Application Project. You should see the New Android Application dialog
window, as shown in Figure 3.1.
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Starting a New Project

- = al
@ Ncw Android Application o 0 ]

New Android Application
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Application Name:@ HelloWorld

Project Name:® HelloWorld

Package N & com
Minimum Required SD&B[AP]B: Android 2.2 (Froyo) v}
Target smeu[APm: Android 4.2 (Jelly Bean) v]
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ThpmﬁﬂlElnne i v}

? Choosc the base theme to usc for the application

@ [ <Back [ MNet> ][ GEnisn ][ cCance |

Figure 3.1 Initial new Android application window configured for “Hello World.”

Fill out the screen as shown. The application name is displayed on the phone’s screen as the
name of the app. You can use spaces if you want. As you type the name, the project name and
package name will be completed. There are no spaces allowed in these items. The wizard will
remove them as you type. Don’t put them back in either of these fields. The package name is
important. For this initial project you don’t need to change the default. However, if you are
building an app for sale, in place of “example” you should put your company name. This iden-
tifier will be used in the Play Store to link your apps to the services they use and connect all
your apps.

Next, click the Minimum Required SDK drop-down. A list of potential Android SDKs are listed.
BBR stands for Software Development Kit, and it is HiSCHOMOOISIANUICOUCHIDIaTICSIUSCARtORNTIte
_ Each release of the Android OS is associated with an SDK so

that programmers can write code for that platform. An application programming interface (API)
is

(Phones and tablets using Android

operating systems earlier than this selection will not even see your app in the Play Store.) This
selection will also determine the features you can program into your app. The recommended
minimum is the default: Froyo API 8. An app that has this minimum will be accessible to more
than 90% of the devices “in the wild.”
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The Target SDK should usually be set to the latest version of the Android operating system. At

the writing of this book, that version is the Jelly Bean (API 17). After you release an app, you
should periodically update these values and recompile your app as new versions of Android
are released. At times, new versions of the operating system can affect the performance of your

app, 50 it is best to keep the app up to date. IHECOMPIEMIHTATEEESHoUIRISOBETE

Themes are a useful way to ensure a consistent look for your app. However, because this is an
introduction you will not be using them in this book. Click the drop-down and select None as
your theme.

After you have verified that your selections match those in Figure 3.1, click the Next button
and the Configure Project window will be displayed. You should accept the defaults on this
screen. After you learn the app creation process, you may want to modify the default settings
to better match your requirements. However, by using the defaults, some work is done for you
that can easily be changed later as needed. Click the Next button to display the Configure
Launcher Icon window.

The ConfighfeLAURCHENICONWIRAON a1lows you FOISSOGALEIANEOR with your app that will
be displayed on the phone’s screen along with the app name. Notice the different sizes of the
icons. If you are providing an icon for your app, JOUNIlIHaVetosUpPIyIseveralisiZzesiofthe
same picture. This is because Android apps can run on any Andsoid device that meets the apps
_ However, these devices can have_
_ By supplying different icon sizes, _
_ This helps ensure that your app will show up as you design it, regard-
less of the characteristics of the device it is running on. Suggested sizes for app icons are 32x32,
48x48, 72x72, 96x96, and 144x144 pixels for low to extra high density screens. Accept the
default icon for this app by clicking the Next button.

The Create Activity window is the next step in configuring your project. An Activity is a core
component of any Android application. Activities are typically associated with a visible screen.

- Click among the different activity options. Notice that when you have selected

some of them, the Next button is disabled. The choices are limited by your choice of minimum
and target SDK. Eclipse won't let you use features that will not work on the devices you

targeted. In this case, because you selected API 8 as the minimum SDK that your app would be
allowed to run on, some activity types are not available, even though they are available in the
target SDK you selected.

From the list of possible activities, choose Blank Activity and click the Next button. The Blank
Activity window is displayed (Figure 3.2). This allows us to configure the first Activity in our
app. With this screen we can change the name of the activities we create. In the Activity
Name text box, delete MainActivity and type HelloWorldActivity. Notice below Activity Name
is Layout Name. As you typed in the activity name, the text in this box changed to reflect

the text you entered. A [§OH is AN HEHHTovides e iR acaN R HeAcHviE .
Layouts are discussed in detail later. For now, just remember that every activity has an associ-
ated layout file.
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Starting a New Project

% New Android Application

| Blank Activity o™
Creates a new blank activity, with an action bar and optional navigational el such as tabs or

SWipEe.

Activity Name® | HelloWorldActivity

Layout Name® actvity_hello_world

Mavigation Typgﬂ[Nnne =

'; The name of the activity clacs to create

@ [ <Back ][ nNet> mnish | [ Concel

L

Figure 3.2 Blank Activity window with default selections.

The final item on this page is Navigation Type. Select it and click among the options. Notice
that just like the Create Activity window, you are not allowed to use some navigation types.
Again this is based on the SDK choices you made earlier. Select None as your Navigation Type
and click Finish. Your app project is created! Depending on the capability of your computer, it
may take some time to create the project. When Eclipse has finished creating your project, your
Eclipse environment should look like Figure 3.3.

Components of the IDE

Many of the items in the IDE will be explained as needed. For now you will examine just a
few. The top center section is the Editor. Much of the development work is done here, includ-
ing the UI design and writing code. It should currently be displaying the layout for the
HelloWorldActivity in Graphical Layout mode. You can switch between graphical layout and
the XML code that generates the layout with the tabs below the layout. One tab will always say

Graphical Layout. The other will be the filename of the layout. In this case it is activity_hello-
world.xml.
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Figure 3.3 Eclipse with the newly created Hello World project.

The left side of the IDE shows the Package Exploter. The Package Explorer_

_ and is used to move between different components of the app. Many of
these items will be generated for you, and many others you will work with as you create your
app. The stcifolde will contain @llfthejavalcode files for the'app. Eachifile typically represents
Bnelclass. Double-click the folder and its subfolders until you see HelloWorldActivity.java. This
is where the code to create the activity’s functionality is written. Double-click the HelloWorld.
java file. The file contents are displayed in the editor with some Java code listed. This code is
explained later.

Next, look for the F@SHoldes in the Package Explorer. This folder contains a number of folders
that all contain a different kind of resource file needed for your Android app. One yery impor-

tant note about resource files: There are _ in the file names! Double-

click through the drawable-xxx folders. The drawable folders are for images. _

_files for its images. Notice the ic_launcher.png file is in all

the drawable folders except the drawable-lhdp folder. Each one of these files is the launcher
icon in a different size to match the size recommendations for different screen resolutions.


Hamid

Hamid

Hamid

Hamid

Hamid

Hamid

Hamid

Hamid

Hamid


Hamid


Hamid


Hamid



Starting a New Project

The lhdp folder does not contain an icon because no Android devices with low resolution are
available with an API 8 or higher. When your app is installed on a device, _

it is installed in by selecting it from the correct
folder.

Next is the layout folder. This folder holds all the layouts for the user interface of your app. The

menu folder holds the menu items to be displayed in your app when a user clicks the device's
_ Menu functionality is not required for an app, and this book will not work

with them.

The final set of folders is that of the values folders. Double-click the Valtesiolder. Three XML
files will be displayed: dimens.xmi, Strings:xmi, and Stylesixmi. The values files hold-
_ Android uses this information to limit the hard-coding of
potentially changeable data. For example, the dimens.xml file could hold a value for screen
title size that could be reused on each layout in the app. If you later decide that you want the
screen title size to be different, you only have to change the value in the dimens.xml file and it
automatically applies the new size to all titles that use that dimension. The values folders with
a dash and number or other information are for values to be used for specific versions of the
Android operating system. This enables the developer to take advantage of different OS capa-
bilities within the same app. Some common values files are described below:

= dimens.xml—Values for the display size of items in a layout.

= color.xml—Values for the displayed color of item in a layout.

= strings.xml—Values for text.

= array.xml—Defines string arrays and the values in those arrays.

= ids.xml—IDs that cannot be reused by items in layouts.

The Android Manifest

The final and very important item in the Package Explorer that we will examine is the

[AfdreidNanitestixmli file. The manifest file is not in a folder but is listed as one of the-
independentfiles foliowing all thefoIdeS IR EhEIIOIEEt Double-click this file. The Manifest

editor will be displayed in the editor. The manifest is used
There are multiple tabs (at

the bottom of the editor) associated with the manifest. These are used to configure different
aspects of your app. The Manifest tab (which is the initial tab open) includes several important
elements. First, note the Version Code and Version Name elements. Version code is an integer
value. It is used to indicate that there is a new version of the app available. Increasing the
value enables the Play Store to notify users of the app that a new version is available. It also
controls the install of the upgrade so that no user data is lost during an upgrade. The Version
Name is the displayed version of your app. Beyond that it is nonfunctioning. However, it is
good practice to have a consistent approach to changing this so that you know what version
of the app is at issue when communicating with users about their problems with the app.
Click Uses Sdk. The current selections for minimum and target SDK are displayed. These can
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be modified here. Next click the Application tab at the bottom of the editor. This tab provides
the capability to configure specific operational and display elements of the app. Finally, click
the AndroidManifest.xml tab. The selections made in the editors generate code that is displayed
here.

Interpreting the XML

Although the tabs in the Manifest editor can be used to create a basic configuration of the
manifest, the ability to read and manipulate XML is a critical skill for the Android app devel-
oper. Modifying a manifest to allow your app to do more advanced behaviors is common,
and most online help on doing so, either from the Android Developer site or developer
forums, is provided in XML. To get started, take a look at the manifest components in the
AndroidManifest.xml file (Listing 3.1).

Listing 3.1 Manifest XML

<?xml version="1.0" encoding="utf-8"?>

//1
<manifest xmlns:android="http://schemas.android.com/apk/res/android"
package="com.example.helloworld"
android:versionCode="1"
android:versionName="1.0" >
/72
<uses-sdk
android:minSdkVersion="8"
android:targetSdkVersion="17" />
//3
<application
android:allowBackup="true"
android:icon="@drawable/ic_launcher"
android:label="@string/app name"
android:theme="@style/AppTheme" >
//4
<activity
android:name="com.example.helloworld.HelloWorldActivity"
android:label="@string/app name" >
//5
<intent-filter>
//6
<action android:name="android.intent.action.MAIN" />
/7

<category android:name="android.intent.category.LAUNCHER" />
</intent-filters>
</activitys>
</application>

</manifest>




Starting a New Project

The manifest contains a number of XML elements. Those elements and their attributes define
basic operational aspects of your app. Refer to the numbers in Listing 3.1 to see the complete
code associated with each element explanation below.

1. The <manifest> component is the root element. The attributes associated with this
element define the application package, version code, and yersion name (as well as
others).

2. The ZUSEEUSEKS element and its attributes define fhe minimum and target SDKS for

the app.

. The ZEppIIEaETSHY clement has both attributes and child elements that COTfigUIeHOW
_ Application attributes in this manifest define the app icon, theme, and
name. element. In our
manifest there is one activity: the one created when we created the project. Its attributes
identify the Java class file for the activity and the display name of the activity. Currently,
that name is the same as the app’s name.

4. The BEGEINEETE clement tells the operating system that an [ACHNINASIDCIIISSIONIY
Bl in your application. SNCHN eSS CaN DR US e derin e hCMANIest - 1
they are not, the app will Bf@8H when the user navigates to that activity. In this element

the JAVaISOUTCEHle for the activity and the HCHNVIGSHILE are identified.

5. A child element of the <activity> element, the <intent-filter> element, defines
what the Android OS should do with this activity. Not all activities will have an intent-
filter. Specifically, activities that you want users to launch when they are using the app
do not need intent-filters. However, for this app you want this activity to be displayed
when the user runs it.

6. Therefore, the Z2EEI6HS tag identifies the activity as the main or first activity to run.
7. The <category> tag tells the OS to use the app launcher to start this activity.

Configuring the Emulator

Now that you have some understanding of the development environment, you are almost
ready to start creating the app. Don’t worry. Future projects will take less time to set up. You
could start coding at this point, but until you tell Eclipse how to execute the app, you will not
be able to see your results. Therefore, the next step will be to set up the test environment.

Android apps may be tested on either the emulator provided by the Eclipse IDE or on an

Android device. The emulator is a program that simulates‘an Android device. If you choose to

test on the emulator, you should also test on several varieties of real devices before you publish

your app. Realldevicesoften perform! differently than fhe émulator. 1f you do not test on a real

device, you will likely have many unhappy users.

To set up the emulator, we first must set up an [CIOIIVITtHANDEVICIAVD). An AVD is-

Multiple AVDs with different charac-
teristics may be set up for testing. To set up an AVD we use the AVD Manager. From the main
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40 Chapter 3 Using Eclipse for Android Development

menu select Window > Android Device Manager to display the Android Virtual Device Manager
(Figure 3.4).

Fs — = — = al
Android Virtual Device Manager E@M
[ Android Virtual Devices | Device Definitions]
List of existing Android Virtual Devices located at C:\Users\Michael Ei ‘\android-cdls\ androidiavd
AVD Name Target Name Platform API Level CPU/ABI

No AVD available Edit...

i

Delete...

i

Repair...

Details...

il

Slail...

]

~ Avalid Android Virtual Device. 5] A repairable Android Virtual Device.
¥ An Android Virtual Device that failed to load. Click 'Details’ to see the error.

L 4

Figure 3.4 Android Device Manager in initial state.

The manager opens with the Virtual Devices tab displayed. Click the Device Definitions tab.
This displays all the device configurations your system knows about. Scroll through these to see
how many devices your app could run on. Press the Device Definitions tab and then click the
New button. The Create New Android Virtual Device (AVD) window is displayed. Complete the
device definition as follows, changing only these options:

AVD Name: MyTestDevice

Device: 3.2 QVGA (ADP2) (320 x 480: mdpi)
Target: Android 4 2.2 — API Level 17

SD Card: Size 1024 MiB

When you click the Device drop-down, a large number of devices are available. Scroll down the
list to find the device: BIZIQVGANADPZIB20X480:mdpi) and select it. After you've selected
the device, choose ARM from the CPU/ABI drop-down. Most devices have an SD card. However,
if you want to test your app for those that do not, don’t change anything for the SD Card
option. Click OK. The new AVD will be displayed in the Android Virtual Devices tab. Click the
new AVD named MyTestDevice that now shows in the existing AVD list, and the buttons on
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Starting a New Project

the right of the AVD Manager will be enabled. Click the Start button and the Launch Options
window will be displayed. Leave all the defaults. Checking the Scale Display to Real Size box
will show the virtual device at the size of the real device. However, this can be hard to use
during initial development. Checking the Wipe User Data box will wipe out any data created in
a previous session. It is useful to leave the data intact so that you will not have to reenter data
every time you want to test some aspect of the app.

Note

| like to start my development with one of the smaller devices because | find it easier to scale
up when developing the user interface than to scale down. Also, | like to pick a lower API for
the device for similar reasons. Later, you can create different AVDs to test different device
configurations.

Click Launch. The Start Android Emulator window will display and start loading the AVD.
When it is done, the virtual device displays (Figure 3.5) and begins further loading. The speed
at which the device loads depends greatly on your computer. At times it can be quite slow. If I
am testing with the emulator, my first task when beginning any development session is to start
the virtual device so that it is ready when I am. After the AVD is displayed, you can close the
Start Android Emulator and AVD Manager windows. The AVD will remain running.

- \
@ 5554MyTestDevice (i

Rasic Controls

Hardware Buttons

ANDROID

Hardware Keyboard
Use your physi board to provide input

L

Figure 3.5 Android Emulator at initial launch.
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Setting Up Run Configurations

The final step in setting up the test environment is to tell our app to use this newly created
AVD. To do this you need to set up a Run Configurations.

1. From the main menu select Run > Run Configurations. The Run Configurations window
is displayed.

2. Click Android Application in the left side of the screen. Then click the New button,
which is the leftmost button above the text box that says Type Filter Text. The window
changes, showing configuration options. Change the name to HelloWorldRunConfig.

3. Use the Browse button to select your HelloWorld project. Click the Launch Default
Activity option button.

4. Click the Target tab. Click the box next to MyTestDevice. When you start testing on
a real device, you will need to click the option button next to Always Prompt to Pick
Device. This displays a device selection window where you can pick the device you want
to test on.

5. Click the Apply button and then the Close button. You are ready to begin coding
your app!

Coding the Interface

As mentioned earlier, the interface for any Android app is created through the use of a layout
file. A layout file is an XML file that contains the XML used to create the objects and controls
that the user can interact with. The first step in coding the HelloWorld app is to modify the
layout so that it has some controls that the user can interact with. Your modifications will

be simple. You will make the app take a name entered by the user and display Hello [entered
name)] after a button click.

Double-click the activity_hello_world.xml file in the layout folder of the Package Explorer to
begin work coding the interface. If it is already open in the editor, click the activity_hello_
world.xml tab at the top of the editor (Figure 3.6, #1). If the Graphical Layout is displayed,
click the activity_hello_world.xml tab at the bottom of the editor (Figure 3.6, #2). The XML
code that creates the user interface is displayed with two elements in it. The root element is a
RelativeLayout. Because Android devices have so many screen sizes and resolutions, it is often
best to design the UI components as relative to one another rather than designing them as a
fixed position. Because the RelativeLayout is the root, it encompasses the whole screen. You
must have only one layout root in an Android layout file. All other items are children of this
root element.

Examine the attributes of the RelativeLayout element (Listing 3.2). A closer look at the attri-
butes reveals a certain structure. Attributes have the format 1ibrary:attribute name =
"attribute value". First, all the attributes in the listing start with android: This indicates
that the attribute is associated with Android SDK library and that is where the compiler should
look for information on what to do. Other libraries are available from third parties. Adding
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Coding the Interface

other libraries will be covered later in this text. The attribute name and values differ based on

the element to which they are applied.

L "actity el weddarm 71 | (1) HellsWerldAethiby jren 1
. Pdette -

Efomwidges || [0 (G - | [EE

P # HelloWorld

Hello world!

Custoem B Library Views | |«

=0

o o] B v| Dtmsce | B -] doppTheme ~| @ruinciiy <] @ | @1 -

Hanas @

[ ]

5] Genplieal Layoun | activity_helia_workd.am] 2

Figure 3.6 Editor and layout tabs.

Listing 3.2 Layout XML

<RelativeLayout xmlns:android="http://schemas.android.com/apk/res/android"

xmlns:tools="http://schemas.android.com/tools"

android:layout width="match parent"
android:layout height="match parent"

android:paddingBottom="@dimen/activity vertical margin"

android:paddingLeft="@dimen/activity horizontal margin"

android:paddingRight="@dimen/activity horizontal margin"

android:paddingTop="@dimen/activity vertical margin"

tools:context=".MainActivity" >

<TextView
android:layout width="wrap content"
android:layout height="wrap content"
android:text="@string/hello world"/>

</RelativeLayout>

//1

//2

//3
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1. The first attributes of interest in the RelativeLayout are android:layout
width="match parent" and android:layout height="match parent". These
attributes define the size of the element. In this case the value "match parent" indicates
that the layout should be the height and width of the device screen. If a child element of
RelativeLayout has this value for either layout_height or layout_width, it will fill up
as much of the RelativeLayout as it can.

2. The next few attributes: paddingRIGHE, paddingLeft, paddingBottom, and
PadaingTop, all tell Android that it should hot fill the entire screen with the

RelativeLayout. Instead, there should be blank space between the edge of the screen and
the edge of the layout. The amount of space is dictated by the value. The values in these
attributes are your first introduction to the use of the XML files in the values folder. To

refer to values from these XML files, Android also has a specific structure. That structure

is [loxmINEiTelnamne/valuelnamen. All values are enclosed in quotation marks. The
value for the attribute android:paddingBottom is_

REZGIHT This tells Android it should use the value named activity vertical margin
from the (@iensixmi file. Double-click the dimens.xml file in the values folder in the
Package Explorer. The file will open to the Resources tab. Click the dimens.xml tab at the
bottom of the editor. This displays the XML used to define the dimensions. The <dimen>
tag is used to define each dimension. Fach dimension has a name attribute, a value, and
then a closing tag that looks like this: </dimen>. The value between the beginning tag
and the closing tag is the value that Android uses as the size of the padding.

Valid dimensions for Android include BXi(pixels), TR({inches), Fmmillimeters), pt
(points), dp/dip (density-independent pixels), and sp (scale-independent pixels). It
is generally recommended that dp be used for most dimensions and sp be used for
specifying font sizes. These two units of measure are relative to screen density. They

help keep your Ul consistent among different devices. The reason that the sp unit is
recommended for fonts is because it also scales to the user’s preference in font size.

3. The only child element of the RelativeLayout, and thus the only item on the screen, is
a TextView. TextView is Android’s version of a label. It is primarily used to display text.
This element currently has only three attributes. The two size attributes differ from the
RelativeLayout in that they have the value "wrap content". This tells Android to size
the TextView to the size of the text displayed in it. The only other attribute tells Android
what text to display. In this case it gets the text from the strings.xml file in the values
folder. Open the strings.xml file and examine the XML to find the “hello_world” item.
Note that its value is “Hello World!”, exactly what is displayed in the running app and
on the Graphical Layout view of the activity_hello_world.xml file. The TextView does
not have any attributes describing its positioning, so Android puts it in the first available
position, which is the very top-left position in the RelativeLayout.

Switch back to the Graphical Layout view of the activity_hello_world.xml file. At the left of
the layout is a panel titled Palette. Palette contains

If it is not open, click on the Form
Widgets folder in the Palette. Form Widgets contains a set of widgets for designing the user
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Coding the Interface

interaction with your app. Hover your mouse over each of the icons to see what type of control
the widget implements. Notice that some controls have multiple versions that enable you to
pick the size that you want for your interface.

A TextView that displays “Hello World” is already on the layout. This is used to display your
app’s message. However, the size of the text needs to be bigger. To the right of the editor
should be a panel with a tab with the label Outline (Figure 3.7). If this is not present, click
Window > Show View > Outline to display it. The top of the tab should show the structure

of the layout. It should have RelativeLayout as its root and textView1 indented below it. The
TextView should be displaying “Hello World” after it. As widgets are added to the layout, they
are displayed in the structure. This is very useful because sometimes controls are added to the
layout that get lost (not visible) in the Graphical Layout. However, if they are in the layout
they will be displayed in the structure.

O X =5
4 [H] Relativelayout

[[#5] TextView - "Hello world!"|

E= Properties %| laz[ B | =
Id
& Layout P... |[]
Text | @string/hello_world (Hello world!)
Hint |
lext Color |
Text App.—| landroid:attr/textAppearanceSmall (@android:st...
Text Size |
Content ... |
2 TedView |[]
Text [ @string/hello_world (Hello world!)
Hint
Text C... |
Text C... |l @android:color/hint_foreground_holo_light
Text A... | Pandroid:attr/textAppearanceSmall (@android:st...
Text Size |
Typeface
Text St... |
Font Fa..|
Text C... |l @android:color/holo_blue_light
Maxi.. |

| » (0

1

IHHDDEINEEDE EEEE @

Figure 3.7 Layout Outline and Properties panels.

Below the structure is the Properties window. If you haven’t clicked anything in the Graphical
Layout, that window will be displaying <No Properties>. Click “Hello World” in the Graphical
Layout. The Properties window should populate with all the attributes that can be set for

a TextView widget. Locate and click the ... button next to the bold attribute Text Size. The
Resource Chooser window is displayed. Two dimensions created when the project was created
are listed (the padding margins). Click the New Dimension button at the bottom of the
Resource Chooser. In the window that opens, enter message_text_size as the dimension name
and 24sp as the value. Click OK until you have closed these two windows. The size of Hello
World! should be increased. Open the dimen.xml file and switch to the XML view to see the
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dimension you created. Close this file and click back to the activity_hello_world.xml tab.
Switch from Graphical Layout to the XML view and examine the XML changes to the TextView
element. Switch back to the Graphical Layout.

Note

The values files are used to hold values that are going to be reused in your app. Unfortunately,
the only way to know what values are available is to open the file and inspect its contents

for the value you’d like to use. We recommend that when you add values, you name them

very clearly and limit the number of values you use to keep it somewhat manageable. Naming
clearly is very important because Eclipse’s code completion capability will list the value names
but not their actual value.

Locate the Small TextView widget just below the Form Widgets folder label. Click and drag it to
the layout, position it as in Figure 3.8, and drop it. Notice the green arrows pointing to the left
side of the layout and to the Hello World! TextView. These arrows show what object the widget
is relative to for positioning purposes. Click the XML view (Listing 3.3). A number of changes
have been made to the XML.

Listing 3.3 Layout XML with TextView Added

<RelativeLayout xmlns:android="http://schemas.android.com/apk/res/android"
xmlns:tools="http://schemas.android.com/tools"
android:layout width="match parent"
android:layout height="match parent"
android:paddingBottom="@dimen/activity vertical margin"

android:paddingLeft="@dimen/activity horizontal margin"
android:paddingRight="@dimen/activity horizontal margin"
android:paddingTop="@dimen/activity vertical margin"
tools:context=".HelloWorldActivity" >

<TextView
//1

android:id="@+id/textView2"
android:layout width="wrap_ content"
android:layout height="wrap content"
android:text="@string/hello world"
android:textSize="@dimen/message text size" />

<TextView
android:id="@+id/textViewl" //2

android:layout width="wrap_ content"

android:layout height="wrap content"

android:layout alignlLeft="@+id/textView2" //3
android:layout below="@+id/textView2"
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android:layout marginLeft="19dp" //4

android:layout marginTop="36dp"

android:text="Name:" //5

android:textAppearance="?android:attr/textAppearanceSmall" /> //6
</RelativelLayout>

1. The Hello World! TextView now has an attribute android:id="@+id/textView2". To
correctly relatively position the new TextView, Android needed a way to reference it so
it added the ID. The +id tells Android to create the ID for the widget. IDs can be defined
in the ids.xml values file. However, to use these IDs for widgets, you need to define
them prior to use, and they cannot be reused. Using +id enables you to tell Android to
create an ID for the widget as you need it. textView2 is not a very useful ID. It does not
describe what the TextView is used for, so change the ID to textViewDisplay.

2. The new TextView also has a +id. However, it is different from the first one. +ids may be
reused in different layouts but cannot be reused within the same layout! Next come the
widget size attributes. All items in a layout must contain these attributes.

3. As the arrows on the Graphical Layout showed, this widget is positioned relative to
the Hello World! TextView. The layout attributes are the XML used to do the relative

positionin. EINEREEEE tels Andoid to align ESIAEEFSIETEIEE e TereTenced
widget's left edge. alignBeLon tells Anduvid to position the widget below the referenced

The margin attributes Tayoutimarginiest and Tayoutimarginmop tell Android HOW
much space to put between the widget and the referenced widget. Change the left

margin to 20dp and the top margin to 55dp. You will often have to tweak these values to
get the layout to look exactly the way you want it to.

5. The BHGESIANEERE attribute indicates WhHat text'should be'displayed. This attribute is

underlined with a yellow triangle on the left edge. This is a warning. Hover over or click
the yellow triangle. The warning is displayed. The value "Small Text" is a hard-coded
value. Android wants all values to be referenced from a value’s XML file. This is for ease
of maintenance. You can change a string value used multiple times just once in the
strings.xml file, and the changes will be made throughout your app. Also, by substituting
a different string’s.xml file, you can adapt your app to different languages more easily.
To simplify this example, leave the string hard-coded but change it to meet your needs.
Delete "Small Text" and replace it with "Name:".

6. The final attribute in the new TextView is fextAppearance. The value for this attribute
references the Android Bl file and is used in place of the textsize attribute. The
attr.xml file is a file supplied by the Android SDK. Switch back to the Graphical Layout
view. The TextView you added should now be displaying Name:.
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48 Chapter 3 Using Eclipse for Android Development

Ul Design—Android Versus iOS

Ul design in Android is done through relative positioning of the controls that make up the inter-
face. However, in iPhone and iPad, absolute positioning is used. Absolute position holds the
control to a fixed position on the screen. The use of absolute position makes the design of
the Ul easier. Unlike in Android, when you move a control it has no effect on other controls in
the Ul. Often in Android, moving one control changes the whole design. This can be frustrating!
When moving or deleting a control in an Android layout, especially if you do this in the XML, be
sure to check the impact of the change in the Graphical Layout.

Interface design is not without its challenges in i0S. Devices that run iOS have a fixed screen
size, which is controlled by Apple. This enables the use of absolute positioning because all
device screen sizes are known by the developer. However, this means that the Ul has to be cre-
ated multiple times for each device that you want your app to run on. These different screens
all run on the same code, so during design, the developer must be sure to be perfectly consis-
tent among the different screens needed.

® Helloworld

Hello world!

Figure 3.8 A Small TextView positioned properly on a Graphical Layout.



Coding the Interface

Locate and click the Text Fields folder in the Palette. A number of widgets for entering infor-
mation are displayed. The widget for entering data in Android is called an EditText. Each of
the EditText widgets listed is configured for the entry of a different type of data. The different
configurations dictate what soft keyboard is displayed when the widget is clicked and, in some
cases, how the text is formatted as it is entered. For example, the EditText with the number 42
in it will display a keyboard with only numbers on it, whereas the EditText with Firstname
Lastname in it will display an alpha character keyboard and it will capitalize each word
entered. Drag the Firstname Lastname EditText to the right of the Name: TextView. As you are
dragging it, pay attention to the green arrows. You want this relative to the Name: TextView,
so there should be only one arrow, and it should point at the TextView. A dotted green line
should go from the bottom of the TextView through the EditText. This aligns the EditText with
the bottom of the TextView.

Click the Form Widgets folder and drag a Small Button below the EditText. In this case you
want the green arrow pointing to the EditText and the dotted green line going through the
middle of the bottom, from the top of the screen to the bottom, to center it horizontally in the
RelativeLayout.

Note

Although Eclipse is a very powerful and useful tool in Android development, the need to make
all items in the Ul relative makes designing a layout difficult. We recommend that you use the
Graphical Layout to get the Ul approximately correct and then fine-tune in the XML.

Switch to the XML view for the layout. Locate the EditText element. Change the default

id to "@+id/editTextName" so that we have some understanding what data that widget is
handling. Change the marginLeft attribute to "5dp". There are two new attributes. The first
is android:ems. This attribute sets the displayed size of the layout to 10 ems. Ems is a size
measurement equal to the number of capital Ms that would fit into the control. The second
new attribute is android: inputType. This attribute tells Android how you want text handled
as it’s entered and the type of keyboard to display when the user is entering data.

Locate the Button element. Change the default id to "e+id/buttonDisplay". There is also a
new attribute in this element: layout centerHorizontal. This attribute is set to true to tell
Android to center the widget in the parent. Finally, change the text attribute to "Display".
Change the value in the layout below attribute to @+id/editTextName to match the change
you made in the EditText element. Switch to the Graphical Layout to see the changes.

Run the app in the emulator using Run > Run Configurations > HelloWorldRunConfig and
click the Run button to see the layout as it would appear running (Figure 3.9). The first time
you run the emulator, you will have to slide the lock to unlock the device (like a real phone).
Note that the emulator might be behind Eclipse, so you will have to minimize windows or in
some other way bring it to the foreground. The button clicks but does not do anything. For this
you need to write code.
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[
& 5554MyTestDevice =] =

Helloworld

Hello world!

Name: [| I
Display

L

Figure 3.9 Initial run of Hello World.

Note

Either close the activity_hello_world.xml file or switch to the XML view after you are done editing
it. The reason is that if you close Eclipse with the layout file open in Graphical mode, Eclipse
will take a long time opening the project the next time you want to work on it.

Coding App Behavior

Code to give behavior to the layout is written and stored in the Java class file associated with
the layout. Open the HelloWorldActivity.java file by double-clicking it. If it is already open,
click its tab in the editor. You should see the basic code structure (Listing 3.4).

Listing 3.4 Initial Activity Code

//1
package com.example.helloworld;

//2
import android.os.Bundle;
import android.app.Activity;
import android.view.Menu;



Coding App Behavior

public class HelloWorldActivity extends Activity {

@Override
//4
protected void onCreate (Bundle savedInstanceState) {
super.onCreate (savedInstanceState) ;
setContentView (R.layout.activity hello world) ;
}
@Override
//5

public boolean onCreateOptionsMenu(Menu menu) {
// Inflate the menu; this adds items to the action bar if it is present.
getMenulInflater().inflate(R.menu.main, menu);

return true;

This code was generated by Eclipse when you created the activity at the start of the HelloWorld
project. It is important to understand what this code does to properly code an activity.

1. At the top of the file is the keyword “package” followed by com.example.helloworld.
This identifies this class as belonging to the Hello World package. All source Java files (in
src folder) will have this entry as the first code in the file.

2. After the package line and before any other code are the imports. Click the plus (+) sign
in front of the import android.os.Bundle; line of code. You should now see three
import lines. This code is used to get the source code needed for your activity. The
Activity class provides the functionality required for any class that uses or interacts with
other Activities used in this class. The Menu class provides the functionality for the menu
that is displayed when the user presses the device’s Menu button. The Bundle import
requires a bit more explanation.

A Bundle is an object for passing data between activities. In this way we can have an
application that can perform some activity based on what another activity has done or

the data it has used. You will use this functionality later in the book. However, Bundle
also performs another very important function. It passes data back to the activity itself.
When the user rotates the device, the displayed activity is destroyed and re-created in the
new orientation. So that the user doesn’t have to start over if this happens, the activity
stores its current state just before it is destroyed in a bundle and passes that data to itself
when it re-creates the activity in the new orientation.

3. The public class line of code begins the Activity class and declares that this class
is referred to as HelloWorldActivity and that it is a subclass of the SDK-provided
Activity class. Within the class are two methods, onCreate and onCreateOptionsMenu.
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52 Chapter 3 Using Eclipse for Android Development

Before each method declaration is @overide. This annotation tells the compiler that the
following method is to be used in place of the super class’s method of the same name.

4. The onCreate method is the first method executed by the Activity when it is started.
The method has a parameter that is of type Bundle named savedInstanceState. This
is the object that contains information on the state of the Activity if it was destroyed in
an orientation change as explained earlier. The next line super.onCreate calls the super
class’s onCreate method. Because this method is overriding the Activity class’s inherited
onCreate method, it must call that method explicitly to use that functionality to create
the Activity. It is passed the savedInstanceState bundle. The final line of code is
setContentView (R.layout.activity hello world). This code tells the activity to
use the activity_hello_world.xml file as the layout to be displayed when the activity is
running. It is very important to understand the parameter RilEyoutHacEIvItyRacIIcl
WBEHE The B parameter tells the compiler that we want to use a [ESOUEGe from the layout
folder named activity hello world. Whenever we want to access or manipulate a
resource, it has to be referred to in this manner. However, this does not refer directly to
the res folders; instead it refers to a file generated by the compiler that is named R.java.
To see this file, double-click into the gen folder in the Package Explorer until you see it.
You should not edit this file because it is automatically generated by the compiler. The
onCreate method will be modified with our code to add further functionality to the
activity.

5. The onCreateOptionsMenu (Menu menu) method is called when the user clicks the
device’s Menu button. It returns a Boolean (true or false) value indicating whether the
menu was successfully created. The first line of code (getMenuInflator ()) gets an object
that can create a menu from the running activity. It then tells it to inflate (create) a
visual representation of the menu based on the main.xml file in the menu resource folder
and refer to it with the name “menu”.

Adding Code

Our app has only one function, to display the name entered into the EditText when the
Display button is pressed. Enter the code in Listing 3.5 before the last curly bracket in the activ-
ity Java file:

Listing 3.5 Display Button Code

//1

private void initDisplayButton() {
Button displayButton = (Button) findViewById(R.id.buttonDisplay) ; //2
displayButton.setOnClickListener (new OnClickListener () { //3

@Override
public void onClick(View arg0) {
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Coding App Behavior

EditText editName = (EditText) findViewById(R.id.editTextName) ; //4
TextView textDisplay = (TextView) findViewById(R.id.textViewDisplay) ; //5
String nameToDisplay = editName.getText ().toString() ; //6
textDisplay.setText ("Hello " + nameToDisplay) ; //7

1

This code does the work and illustrates a number of important concepts in Android
development.

1.

This line declares a new method in the HelloWorldActivity class. The method is only
useable by this class (private) and does not return any value (void). The method
signature is initDisplayButton (). The signature, or name, of the method is completely
up to you. However, you should name it to give some idea what it does.

. Associate the code with the button on the layout. This line of code declares a variable

of type Button that can hold a reference to a button and then gets the button reference
using the command findviewById. All widgets on a layout are subclasses of the view
class. The method £indviewById is used to get a reference to a widget on a layout so

it can be used by the code. The method can return any view object, so you have to use
(Button) before it to cast the returned view to a Button type before it can be used as a
Button by the code. Button is underlined in red after you type it in. This is because the
code for the button class is not automatically available in the class. You have to import
it. Fortunately, this is easy. Hover your cursor over the underlined word and a menu will
pop up. Select Import Button... Do this for any other items underlined in red.

Set the button’s listener. There are a number of different listeners for widgets, which gives
great flexibility when coding app behavior. For this button we use an onClickListener.
The code creates a new instance of the listener and then adds a method (public void
onClick (View arg0)) to be executed when the button is clicked.

. The code for when the button is clicked gets references to the EditText where the name

was entered and the TextVview where the message will be displayed.

The name entered by the user is retrieved from the EditText and stored in a String
variable named nameToDisplay.

The text attribute of the TextView is changed to the value of the String variable.

Notice that initDisplayButton () is underlined in yellow. This is because the method is never
called by the code. To call it and get the behavior associated with the button to execute, you
have to call the method in the onCreate method. After the setContentView line of code enter

initDisplayButton() ;

The yellow underline goes away and your code is done! Run the app in the emulator using Run
> Run Configurations, and click the Run button to test your first app. You could also run your
app using Run > Run or by pressing Ctrl+F11.
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Connecting Code to Ul—Android Versus i0OS

In both Android and iOS (iPhone and iPad), the user interface (Ul) and the code that makes

the Ul work are stored in different files. This means that both types of app coding require that
the code has to be linked to the Ul in some way. The chapters in this book that cover i0OS
explain the process of “wiring up” an interface using the features of the Xcode IDE. However, in
Android, connecting the Ul to the code is done entirely in the code itself.

Whenever some code needs to use a widget on a layout, it has to get a reference to it

using the £indviewById command. This requires extra coding but provides great flexibility.
Forgetting to connect the code to the Ul widget needed in both operating systems will result in
a runtime error.

Summary

Congratulations! You have built your first app. You created an Android project, designed and
coded a user interface, and, finally, made the app do something. Along the way you learned the
process of Android App development, the Eclipse development environment, and the compo-
nents of an Android app.

Exercises

1. Change the Hello World app to allow the entering of a first and a last name and display
“Hello firstname lastname!” when the button is clicked. Be sure to label the EditTexts to
reflect the new data that is to be input.

2. Add a Clear button. The Clear button should remove any data in the EditText(s) and
change the display back to “Hello world!”

3. Create a new Android Virtual Device that uses a bigger device to test your app on a
different screen size. Run the app using the new AVD.
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Android Navigation and
Interface Design

App development for mobile devices is, as discussed in Chapter 2, “App Design Issues and Consider-
ations,” both similar to and different from development for other platforms. Navigation within an app
follows this pattern. Different functionality is provided on different screens (windows in a traditional
environment), and the app designer has to both provide the capacity to switch between those screens
and make it easy and relatively obvious for users to do so when they want or need to access the func-
tionality provided by them. Likewise, screen design is both similar to and different from the traditional
user interface design. In a traditional environment, a window design is made up of a set of visible
objects that give the user the ability to accomplish some component of the overall task. This is the same
in the mobile environment. However, the objects available for design differ in both form and function,
the amount of screen real estate available is much more limited, and often the amount of real estate
available changes among devices that can use your app. This chapter introduces you to many of the
principles and components of interface design and navigation in the Android platform. To learn these
things, the chapter guides you through the development of MyContactList navigation and the develop-
ment of the Contact interface.

Activities, Layouts, and Intents

The primary structiiral Components for an Android app are ASESUIEIES and ESVEUES. These
Objects work together to present a display that the user can interact with. Intents are objects

that are used to switch between activities in an app. All three objects are used as the basis for
the structure of your app. Understanding the role and responsibilities of these objects is very
important to effective development of an Android app.
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The Activity Class

The Activity class is designed to handle a single task that the user can perform. Activities
almost always have a visible component that allows the user to interact with the activity to
perform the task. [FHEIACEIVIEYIclasslisimotidirectlyinstantiated in an Android app. Rather,
itisstbeIassediforievery activity thatithe iserimeeds to perform in the app. These subclasses
are Storediasiigavartiles ifi the app project’s BEeHolder. This allows developers to inherit all

the functionality of the Activity class and add their own unique functionality through Java
code. One of the most important inherited functions of the Activity class is the capability to

fespond tollife cycle events Sich as SRCEEaEE and SHBAUSE (refer to Chapter 2 for a discussion

of the Android life cycle).

The Activity class has'a number of important subclasses. Only two of these subclasses are

used in this book. The first of these is EragmentActivity. Fragments were a new addition to
the Android OS in the HoneyComb version (SDK 11). Fragment_
_ If you are targeting only versions of Android
later than SDK 11, you're not likely to use the FragmentActivity subclass because this class is
used to make an app backward compatible to OS versions earlier than 11. Because this book’s
focus is to build apps that may be run on as many devices as possible, SDK 8 is used as the
minimum rather than 11. Therefore, in addition to the Activity class, at times you will need
to use the FragmentActivity class. Map objects require the use of the FragmentActivity
subclass. You will use this class in Chapter 7, “Maps and Location in Android,” when you
implement the map functionality of your app.

The second Activity subclass you will use is ListActivity. HSENCEIvEEY is GESIEHedg
SPECHCAINSUPPOINEGEEIOpMERTONANISEIRISHILE A 1ist is a very useful way to present a

large amount of data in a manner that makes it easy for users to navigate through to find the
data they are interested in. The ListFragment class is used in Chapter 6, “Lists in Android:
Navigation and Information Display,” when you implement the contact list functionality of

your app.

Layout

A layout is the visual component of a user interface in Android. The layout is not a class
but rather an XML file that is used to tell the operating system what visual objects are to be

displayed, how those objects are configured, and where those objects should be displayed on
the screen. The XML in the file does use objects. The objects that make up an Android inter-

face are referred to as widgets. - are Subclasses of the View class. Android widgets include

widgets to define where other widgets are displayed (for example, RelativeLavout), to directly
interact with the user (for example, RadioButton), and to provide some type of navigation 3

within the interfaces (for example, Scrollview). Developing an understanding of the layout
XML is a critically important task for the new Android developer.

Layouts can also be defined at runtime by instantiating the widgets that make up an interface
and configuring them as needed. This can be very useful in some cases. However, designing the
interface is more difficult because you cannot see the layout until you run the app. You will be
designing your interface with XML in this book rather than at runtime.
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Creating the Interface

Intents

An Intent is a class that is used to describe an operation to be performed. Int=nts are the

primary way in which the developer starts new activities within the app. This is how you will
use them in the app you develop for this book. However, Intents can also be used to commu-
nicate between activities. An Intent is essentially a message that defines an action to be taken
and the data that the action is to be performed on. Intents can be used to start activities or
broadcast both within and outside the app to provide instructions and data to other activities.

Activities, layouts, and intents are important components of an Android app. You will use all of
them in almost every app you develop.

Creating the Interface

The MyContactList app requires four activities and four layouts to provide the functionality
described in Chapter 2. The app will use Intents to switch between activities and pass data
between these activities. Your first task in creating the MyContactsList app is to make sure you
have access to the image resources provided with this book. You will need four image files.
One image is the app icon (appicon.png) and the other three are used in the app for naviga-
tion (contactlisticon.png, settingsicon.png, mapicon.png). Every app needs a project, and
MyContactList is not different. Your second task is to create a new project.

Importing a Project
The completed project for each chapter is available in the online resources for this book
(https://github.com/LearningMobile/BookApps). You can import the project by following these
steps:

1. Unzip the chapter code.

2. Create a new project by selecting File > New > Android > Android Project from Existing
Code. Click Next.

3. Use the Browse button to navigate to the unzipped code folder. Select MyContactList,
check Copy Projects into Workspace, and click Finish.

The project will be created in your workspace. You will have to set up a Run Configuration to
execute the app. If you don’t want to import the whole project, you can inspect the different
files by navigating through the MyContactList folder.

Sometimes when importing a project, Eclipse has problems. If your imported project will not
run, do the following:

1. Right-click the project name and select Properties > Java Build Path.

2. Click the Order and Export tab.

3. Check Android Private Libraries. Click OK.

4. Clean the project (Project > Clean).
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Create the Project
Create a new Android project by selecting File > New > Android Application project.
1. Use the following values for the first window presented by the project creation wizard:
Application Name: MyContactList
Project Name: MyContactList
Package Name: com.example.mycontactlist
Minimum Required SDK: API 8
Target SDK: API 17
Compile with: API 17
Theme: None
2. Click Next. Accept the defaults on this screen by clicking Next again.

3. On the Configure Launcher Icon window, use the Browse button to select appicon.png
from the location where you placed the resource files (available online). Click Next.

4. On the Create Activity window, verify that Blank Activity is selected, and click Next.

5. Change the name of the activity to ContactActivity in the Blank Activity window. Make
sure the navigation type is set to none. The navigation is coded by you later in the
chapter. Click Finish.

To code the navigation, you need more than one activity. Create three more blank activi-
ties using the following process. Expand your MyContactList project in the Package Explorer.
Expand the src folder. Expand the com.example.mycontactlist folder so that you can see
ContactActivity.java. Right-click com.example.mycontactlist (Figure 4.1).

I2 Packagebxplorer 2 | BE1 2 ¥ = O \dl activity_contactamnl 52
4 &= MyContactList 4 : Palelle

4 [ sic | Palette -

4|t com, ple.my| -
b [J] ContactActivi New %

p &8 gen [Generated Java Go Into |

| B4 Android 4.2.2 P,

1 =8 Android Dependenci Lt S
GI@ assets Open Type Hierarchy H

b & bin Show In Alt+Shift+W »
a.

1 = libs

a B e & Copy CtrisC
w2 deswahlechdni | 52 Coov Oualified Name

Figure 4.1 Adding a new activity.

1. Select New > Other. The Select a Wizard window displays. Expand the Android section
and double-click on Android Activity.
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Creating the Interface

2. Select Blank Activity and click Next. Enter ContactListActivity for the name of the
activity and Contact List as the title (Figure 4.2). Click Finish.

Blank Activity
Creates a new blank activity, with an action bar and optional navigational el such as tabs or
hor | swipe.
Project: MyContactlist - =
Activity Name® ContactListActivity
Layout Name® activity_contact_list
Title8| Contact List
8[] Launcher Activity
Hierarchical Parent® Optional E]
] Typeﬂ[Nnne V]
'; The name of the activity. For launcher activities, the application title.
@ [ <Back ][ mNet> [ Fmish ][ conedl

Figure 4.2  New Activity properly configured.

3. A new file, ContactListActivity.java, is entered in the Package Explorer right below
ContactActivity.java. If it is somewhere else, right-click the file and click Delete. Start
over. The file must be in the source code folder for your package, or the app will not run
correctly.

Repeat this process to add another two activities to your project. Give the activities the names
ContactMapActivity and ContactSettingsActivity. Set their titles to Contacts Map and Settings,
respectively. Find the res folder in the Package Explorer and expand the layouts folder. You
should have four layout XML files, one for each activity.

Create the Navigation Bar
The navigation bar for the MyContactList app sits at the bottom of the screen and allows the
user to quickly move between different functions in the app by tapping one of the images on

the bar (Figure 4.3). The navigation bar is made up of three ImageButtons contained within a
RelativeLavout. The RelativeLayout is set to be just big enough to hold the three buttons

and placed within the root RelativeLayout that was placed in the layout file by the wizard

Navigation Bar asawai 43y jlal ung 3y
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when you created the activity. The navigation layout is anchored to the bottom of that layout
so that it always appears at the bottom of the screen.

Figure 4.3 Complete navigation bar layout.

ImageButtons can only use image files that are within the project. To add the images to the

project:

1.

Right-click on the drawable-hdpi folder in the res folder and select Import from the
pop-up menu.

. In the Import window that opens, expand the General folder and select File System.

Click Next.

. Click the Browse button in the File System window and navigate to the location where

you placed the contactlisticon.png, settingsicon.png, and mapicon.png files.

Click the check box next to each image you want to import and click Finish. Expand the
drawable-hdpi folder to verify the import.

Open the activity_contact.xml file if it is not already open by double-clicking it in
the Package Explorer. Make sure that it is open in the Graphical Layout in the Editor
window.

Click the Hello World! TextView and delete it.

Open the Layouts folder in the Palette to the left of the Graphical Layout. Locate

the RelativeLayout and drag it onto the MyContactList layout. Position the layout
anywhere on the screen. The exact location is set by you in the XML later in this chapter.
The size of the layout is very small because the default 1ayout height and layout
width attributes are initially set to "wrap content." Initially, the layout has no widgets
in it so it sizes very small. This makes it difficult to place widgets within it. Fortunately
there are approaches to working around this issue. Open the Images and Media folder

in the Palette and make sure that the Outline display is visible on the right side of the
editor (Figure 4.4).

Click and drag an ImageButton from the Palette across the editor to the outline. Position
the cursor on the indented RelativeLayout below the root RelativeLayout and
release. A window opens that allows the selection of the image.

Select contactlisticon and click OK. The outline should look like the right side of
Figure 4.4, and the button with the icon is displayed in the Graphical Layout.
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2% Outline 11 = 0 | 5= Outline & =0
Pl E Relatrvelayout a RelativeLayout
7] Relativelayout a [0 Relativel ayout

’m imageButtenl - contactlisticon

Figure 4.4  Outline before and after ImageButton drag and drop.

Now that the RelativeLayout has some content, it is easier to work with.

1. Switch to the activity_contact.xml view in the editor. Locate relativeLayoutl’s
layout width attribute and change its value from "wrap content" to "£ill parent".

2. Switch back to Graphical Layout. Click relativeLayout1 in the Outline. A much bigger
layout should be highlighted. Drag another image button to the right of the first one and
select the mapicon image.

3. Repeat step 2 for the last button. Use the settingsicon image and make sure it is
positioned to the right of the mapicon button.

The layout may look a little strange, but that’s okay for now; final configuration will be done
with XML. However, before you do that, you have to create a color resource to give the layout
the proper background color.

To create a color resource, navigate to the values folder in the res folder and right-click it.
Select New > Other from the pop-up menu and complete the following steps:

1. Expand the Android folder in the Select a Wizard window and select Android XML
Values File. Click Next.

2. Type “color” into the File: text box. Click Finish.

3. The Android Resource editor opens in the editor window. Click the Add button. Select @
Color in the window that opens and click OK.

4. Type “navbar_background” for the Name and “#1ala48” for the value. Switch to the
XML view by clicking the color.xml tab at the bottom of the editor. Your XML should
look like that in Listing 4.1.

Listing 4.1 Resource XML

<?xml version="1.0" encoding="utf-8"?>
<resources>
<color name="navbar background"s#lala48</color>

</resourcess>

Close the color resource file by clicking the x to the right of the color.xml name tab at the top
of the editor. Be sure to click Yes to save the changes. Switch to activity_contact.xml. The rest
of the navigation bar will be configured in XML.
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Several changes need to be made to the XML to give the navigation bar the correct look.
First, you will change the default layout of the whole screen. Second, the navigation bar
RelativeLayout is modified to position it at the bottom of the screen and have the blue
background color. Finally, the layout of the ImageButtons are modified to center the middle
button and position the other two buttons around it. Refer to Listing 4.2 to complete the navi-

gation bar.

Listing 4.2  Activity_Contact.xml

<RelativeLayout xmlns:android="http://schemas.android.com/apk/res/android"
xmlns:tools="http://schemas.android.com/tools"

android:layout width="match parent"

android:layout height="match parent"

tools:context="

<RelativeLayout
android:id=

.ContactActivity" >

"@+id/navbar"

android:background="@color/navbar background"

android:layout_width="fill parent"

android:layout height="wrap content"

android:layout alignParentBottom="true" >

<ImageButton

android:
android:
android:
android:
android:
android:

android

id="@+id/imageButtonList"
layout_width="wrap content"
layout_height="wrap content"

layout centerVertical="true"

layout toLeftOf="@+id/imageButtonMap"
layout _marginRight="20dp"
:src="@drawable/contactlisticon" />

<ImageButton

android

android:
android:
android:
android:
android:

:id="@+id/imageButtonMap"
layout width="wrap content"
layout height="wrap content"
layout centerVertical="true"
layout_centerHorizontal="true"
src="@drawable/mapicon" />

<ImageButton

android
android
android

:id="@+id/imageButtonSettings"
:layout width="wrap content"”
:layout_height="wrap content"

//1

@+id/navbar
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android:layout centerVertical="true"
android:layout marginLeft="20dp"
android:layout toRightOf="@+id/imageButtonMap"
android:src="@drawable/settingsicon" />

</Relativelayout>

</Relativelayout>

Very specific changes need to be made to the XML to get the desired look. The following
explains the changes to each widget in the activity_contact.xml.

1. The first change is to the default layout attributes of the whole screen. By default,
the Blank Activity Wizard puts padding around the layout. To use the whole screen,
these attributes have to be removed. Locate the paddingBottom, paddingTop,
paddingLeft, and paddingRight attributes in the root RelativeLayout and delete

them.

2. The RelativeLayout that contains the ImageButton is changed to a position at the
bottom of the layout and is given a dark blue background and a meaningtul ID.

a.

b.

Add an id attribute using this code: android:id=@+id/navbar.

Add the backaround attribute and set its value to "@color/navbar
background. " This refers to the color resource file previously created.

Add the layout_alignParentBottom attribute and set its value to “true.” This
tells Android to always position the layout at the bottom of the screen regardless of
any other widgets in the layout.

Finally, remove all other attributes not shown in the listing. These are left over
from the random positioning of the layout when it was first dragged to the layout.

3. The two image buttons on either end of the navigation bar are positioned relative to the
middle button, which is centered in the layout. All buttons are given meaningful IDs.

a.

b.

Change the id of the first button to "@+id/imageButtonList."

Add the attribute layout toLeftOf and set its value to "@+id/imageButtonMap."

Add the attribute layout marginRight and set its value to "20dp" to position it
to the right of the centered Map button.

Add the attribute centervVertical and set its value to "true."

Remove all other attributes not shown in the listing. Note the src attribute and its
value. This is where the image file is associated with the ImageButton. The image
can be changed by changing its value.

4.-5. Modify the remaining buttons in a similar way to match the XML in the listing.

63


Hamid

Hamid

Hamid

Hamid

Hamid

Hamid

Hamid

Hamid

Hamid

Hamid

Hamid

Hamid

Hamid

Hamid


64

Chapter 4 Android Navigation and Interface Design

Note

You may get two warnings after you have completed the preceding changes. The first warns
that the RelativeLayout may be useless. This is because you have a RelativeLayout
within a RelativeLayout that has no other objects in it. After you add other objects later

in this chapter, this warning will go away. The second warning is “Missing contentDescription
attribute on image.” The contentDescription value is used by alternative access modes,
such as a screen reader that describes what is on the screen. You can safely ignore this warn-
ing. If you want your app to be accessible in a nonvisual manner, include the following in your
ImageButton XML: android:contentDescription="your description of the image".

Switch to the Graphical Layout view. The navigation bar should be dark blue, positioned at the
bottom of the screen, and the map button should be positioned in the center. If this is not the
case, review the XML to make sure it matches Listing 4.2.

When the navigation bar is properly configured, you can copy it into each of the other

three layouts. Switch to activity_contact.xml, and then highlight and copy all the XML

that defines the navigation bar. Be sure to include the start <RelativeLayout and end
</RelativeLayouts> tags. Open the activity_contact_list.xml file in the layouts folder by
double-clicking it. Switch to the XML and delete all the XML associated with the “Hello World”
TextView that was automatically generated when you created the Activity. Paste the copied
code just before the last </RelativeLayouts> tag in the file. Delete the padding attributes

in the root RelativeLayout. Switch to Graphical Layout to verify that the navigation bar

is properly displayed. Close the file and repeat the process to add the navigation bar to
activity_contact_map.xml and activity_contact_settings.xml.

Create the Contact Layout

The contact activity provides functionality associated with adding and modifying information
about individual contacts. Although it is the most complicated layout in the MyContactsList
app, it also demonstrates the use and configuration of a significant number of interface
elements available in the Android platform. The relative nature of Android layouts makes
development challenging; however, the concepts discussed in this chapter should help make
the creation of a layout routine.

There are three major sections in this layout. The navigation bar completed in the previous
section is one of these. One of the other two is another RelativeLayout at the top of the
screen to display the buttons that allow the user to access overall functionality for the screen—
in other words, a layout that will function as a toolbar. The other is a Scrollview that holds
all the widgets that allow the user to enter information about a contact. A Scrollview is used
to ensure that users can access all the data entry widgets regardless of the size of their device.

Create the Toolbar

The toolbar consists of a RelativeLayout positioned at the top of the root layout, a
ToggleButton to switch between editing and viewing modes, and a Button to allow the user
to save changes to the contact’s information. Open activity_contact.xml if it is not already
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open. Switch to Graphical Layout and drag a RelativeLayout to the screen. Don’t worry
about its position, but do not put it on the navigation bar. Again the RelativeLayout is very
small, so you'll have to use the Outline to load the first widget. Open the Form Widgets folder
in Palette and locate the ToggleButton widget (the one that says Off). Drag the ToggleButton
to the new RelativeLayout in the Outline.

Switch to the XML view and change the RelativeLayout's layout width attribute’s value
to "match parent". Switch back to Graphical Layout and drag a Button to the right of the
ToggleButton. The last thing to do before switching to XML to configure the toolbar is to
create another color resource for the toolbar’s background. Double-click the color.xml file. If
the file opens to XML, click the Resource tab at the bottom of the editor and click the Add
button. Add the color resource with the name “toolbar_background” and value “#bebebe”. Save
and close the color resource file.

Switch to XML view and refer to Listing 4.3 to modify the XML so that the toolbar appears at
the top of the screen with the proper size and widget spacing.

Listing 4.3 Toolbar XML

//1
<RelativeLayout
android:id="@+id/toolbar"
android:background="@color/toolbar background"
android:layout width="match parent"
android:layout height="wrap content"
android:layout_alignParentLeft="true"
android:layout_alignParentTop="true" >
//2
<ToggleButton
android:id="@+id/toggleButtonEdit"
android:layout width="wrap content”
android:layout_height="wrap content"
android:layout_alignParentLeft="true"
android:layout marginLeft="20dp"
android:text="ToggleButton" />
//3
<Button
android:id="@+id/buttonSave"
android:layout width="wrap content”
android:layout height="wrap content"
android:layout alignParentRight="true"
android:layout marginRight="20dp"
android:text="Save" />

</RelativeLayout>
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There are only a limited number of new attributes to discuss in the XML. Make sure your
toolbar XML matches the listing.

1. The layout alignParentTop attribute locks the relative layout to always appear at the
top of the devices screen. The layout alignParentLeft locks the RelativeLayout
to lock its left edge to the left edge of the screen. Technically, the alignParent
attributes do not lock to the screen but refer to the containing layout. Since the root
RelativeLayout is the containing layout it has the effect of locking to the screen edges.

2-3. The layout alignParentLeft and layout alignParentRight attributes used in the
ToggleButton and the Button refer to the toolbar RelativeLayout as the parent. With
these attributes set to true it does not matter where the layout is placed. They will always
remain fixed to those positions within the layout.

Switch to Graphical Layout. The toolbar should appear at the top of the screen with a gray
background (see Figure 4.5).

OFF Save

—_—

Figure 4.5 Complete toolbar layout.

Create the Data Entry Form

The data entry portion of the ContactActivity allows users to enter information on their
contacts. The data entry form primarily relies on the EditText and TextView widgets that
were introduced in the Hello World! app. New concepts introduced include configuring the
EditTexts to limit and format the input, movement (tabbing) through the data entry widgets,
using a custom pop-up window to enter the birthday with a DatepPicker widget, and using a
ScrollvView to expand the “real estate” available. The Birthday button and its functionality
shown on the screen in Chapter 2 are added in Chapter 8, “Access to Hardware and Sensors in
Android.”

Open the activity_contact.xml file (if it is not open) and switch to Graphical Layout. Open the
Composite folder in the Palette. Drag a Scrollview to anyplace between the toolbar and the
navigation bar. Notice that just like the RelativeLayout, the Scrollview is too small to be
useful. Switch to activity_contact.xml to edit the XML so that it is usable. Refer to Listing 4.4 to
properly configure the Scrollview.

Listing 4.4  ScrollView XML

//1
<ScrollView
android:id="@+id/scrollViewl"

android:layout width="match parent"
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android:layout height="wrap content"
android:layout alignParentLeft="true"
android:layout below="@+id/toolbar"

android:layout above="@+id/navbar" >

<RelativeLayout
android:layout width="match parent"
android:layout height="match parent" >

</RelativeLayout>
</Scrollviews

Examine the XML on your screen. Notice that it is somewhat different from Listing 4.4. These
differences are explained below. Change your XML to match Listing 4.4.

1. The layout width attribute is changed to "match parent" to use the full screen. The
height is left as "wrap content" to allow the ScrollView to expand or contract based on
its contents and the device size. The margin attributes are eliminated to allow the use of
the full screen. Finally, the layout above attribute is added to prevent the ScrollView
from overwriting the navigation bar.

2. By default, the Scrollview has a LinearLayout as its only contents. ScrollvViews can
have only one widget as their contents. However, if that widget is some type of layout,
more widgets can be added as long as they are within that layout. LinearLayouts allow
a simple display of widgets one right after the other either vertically or horizontally. To
get a more complex display, the LinearLayout is replaced with a RelativeLayout. You
could do this by deleting the LinearLayout and then dragging a RelativeLayout onto
the scrollview. However, it is far easier just to change the XML. Change your XML to
match that in the listing.

After making the changes to the XML, switch back to Graphical Layout. The basic structure of
the data input screen is complete. The next step is to add the widgets that the user can interact
with to save contact information.

Open the Form Widgets folder in the Palette and drag a Small Textview (Small Text) onto the
Scrollview. You might have trouble with this. The Scrollview is set to be the area between
the toolbar and the navigation bar. However, you cannot place a widget in the Scrollview
because it already has its one widget, the RelativeLayout. Although the RelativeLayout

is set to match the parent Scrollview's height and width, the lack of content is making it
wrap its content to a very small area. If you are having problems, drag the TextView to the
RelativeLayout in the Scrollview in the Outline area instead. Then switch to XML view and
modify the TextViews attributes so that its ID is textContact, is aligned to the top and left

of its parent, and it has a left margin of 10dp, a top margin of sdp, and displays Contact: as
its text.
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Add an EditText for the user to enter the contact name. Open the Text Fields folder in the
Palette and drag an abc EditText to underneath the Textview. Switch to the XML and refer
to Listing 4.5 to configure the EditText.

Listing 4.5 Contact Name EditText XML

<EditText
android:id="@+id/editName"
android:layout width="wrap content"
android:layout height="wrap content"
android:layout alignParentLeft="true"
android:layout marginLeft="10dp"
android:layout below="@+id/textContact"

android:ems="14" //1
android:imeOptions="actionNext" //2
android:inputType="textCapWords" > //3
<requestFocus /> //4
</EditText>

Modify the XML as shown. You have worked with many of the attributes already. However, a
few require additional explanation:

1. The ems attribute tells Android how big the EditText should be. The unit ems is the
number of capital M'’s that could fit into the widget. It often takes some experimentation
with the number to get the widget to size the way you'd like it.

2. The imeOptions="actionNext" attribute/value pair tells Android to show a Next button
on the soft keyboard. When the user presses that button, focus will move to the next
EditText. This is how tabbing is implemented in Android apps.

3. The inputType attribute tells Android what type of keyboard to display and how to
format the data as its entered. The value textCapWords tells Android to display an alpha
keyboard and to capitalize each word as it’s entered.

4. The final item in the XML <requestFocus /> is not an attribute. It is a tag to tell
Android to put the cursor in this widget when the layout is displayed. You should have
only one of these in a single layout file.

Switch back to Graphical Layout to review the impact of the changes. Switch back to the

XML. The next widget _ Locate the TextView XML and

copy all of it from the <TextView initial tag and including the /> closing tag. Paste it after the
EditText XML. Modify the XML to match Listing 4.6.
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Listing 4.6 Address TextView XML

<TextView
android:id="@+id/textAddress"
android:layout width="wrap content’
android:layout height="wrap content"
android:layout_alignParentLeft="true"
android:layout below="@+id/editName"
android:layout marginLeft="10dp"
android:layout marginTop="15dp"
android:text="Address:"
android:textAppearance="?android:attr/textAppearanceSmall" />

Next, copy all the EditText XML and paste it after the Textview XML. Be sure to include the
</EditText> closing tag. Delete the <requestFocus /> tag. Refer to Listing 4.7 to configure

the XML.

Listing 4.7

Address EditText XML

<EditText

android:
android:

android

android:
android:
android:
android:
android:
android:

</EditText>

id="@+id/editAddress"
layout width="wrap content’

:layout_height="wrap content’

layout_alignParentLeft="true"
layout marginLeft="10dp"

layout below="@+id/textAddress"
ems="14"
imeOptions="actionNext"
inputType="textCapWords" >

Switch to Graphical Layout. Your layout should look like Figure 4.6. If it does not, return to the
XML and verify your settings.

The next step is to add the three EditTexts required to enter the city, state and zip code of the

contact. Drag and drop or copy XML to add these widgets to your layout. Refer to Table 4.1 for
parameter values for each EditText. Attributes that have a value “---” in the table should not
be included for that particular widget. The table introduces three new attributes. The layout
toRightOf attribute is used in place of the layout_below attribute to position a widget next
to another widget. The layout_alignBottom attribute tells Android to lay out the widgets so
that their bottom edges match, regardless of height or width of the widget. Some input has

a limited number of characters that should be entered. The maxLength attribute is how the
developer limits the number of characters that can be entered into an EditText. Finally, the
nextFocusDown attribute is used when it is difficult for Android to figure out which of the
EditTexts should get focus next. This attribute is used to specifically identify which widget
should get focus after the current one.
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Figure 4.6 Contact layout.

Table 4.1 Attribute Values of City, State, and Zip Code EditTexts

OFF
—_—p

Contac)

Address;

&1 MyContactList

Widget City State Zip Code
Attribute

+id editCity editState editZipcode
layout_width wrap_content wrap_content wrap_content

layout_height
layout_alignParentLeft
layout_marginLeft
layout_below
layout_toRightOf
layout_alignBottom

ems

wrap_content
true

10dp

@+id/editAddress

wrap_content

@+id/editCity
@+id/editCity
2

wrap_content

@+id/editState
@+id/editState
4
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Widget City State Zip Code
maxLength - 2 5

imeOptions actionNext actionNext actionNext
nextFocusDown @+id/editState @+id/editZipcode @+id/editHome
inputType textCapWords textCapCharacters numberSigned

Verify with Graphical Layout that the interface looks like Figure 4.7. If everything looks correct,
the next step is to add the phone number fields. You will need to add two TextViews and two
EditTexts to the layout for the phone information. Configure the widgets using the informa-

tion in Table 4.2

Table 4.2 Attribute Values of Phone Widgets

Widget Home Text Home Edit Cell Text Cell Edit
Attribute

+id textHome editHome textCell editCell

text Home Phone: - Cell Phone: -
layout_width wrap_content wrap_content wrap_content wrap_content

layout_height
layout_alignParentLeft
layout_marginLeft
layout_marginTop
layout_below
layout_toRightOf
layout_alignBottom
layout_alignLeft
ems

maxLength
imeOptions
nextFocusDown

inputType

wrap_content
true

10dp

15dp
@+id/editCity

wrap_content
true
10dp

@-+id/textHome

7

14
actionNext
@+id/editCell

phone

wrap_content

@+id/textHome
@+id/editCell

wrap_content

@+id/editHome
@+id/editHome
7

14

actionNext
@-+id/editEMail

phone
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&1 MyContactList

Contact

Address;

Figure 4.7 Contact layout with address fields.

The phone number labels (TextViews) are above the EditTexts used for input of those phone
numbers. This layout poses challenges because the size of the EditText inputs can and will
change based on the device the user runs the app on. Given that, you cannot set the labels at a
fixed position because the inputs below them will change and no longer align with their labels.
This makes the interface look sloppy.

The solution implemented in XML provided earlier is to align the cell phone label with the
bottom of the home phone label, but rather than position it to the right of the home phone
label, you align it with the left edge of the cell phone input. That way, as the EditTexts
change size, the cell Phone: label will always be directly above the cell phone input. A new
attribute value/pair, layout alignLeft="e+id/editCell, is used to implement this solution.
One other item of note in these widgets is the maxLength attribute of the EditTexts. Note
that they are set at 14 rather than 10, which is the number of digits in a U.S. phone number.
The maxLength of input is the total length, including formatting and spaces. When format-
ting is added to the phone number, the input length becomes greater than 10. For example,
a phone number formatted as (111) 222-4444 would be 14 characters long. When completed,
your layout should look like Figure 4.8.
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& MyContactList

OFF Save
— 2 e
Contac)
Address;
Home Phone; Cell Phone;

Figure 4.8 Contact layout with phone fields.

The final elements of the contact activity layout are the email and birthdate inputs. You need
a TextView and an EditText for the email input and two TextViews and a Button for the
birthday input. One of the birthday Textviews will be used to display the birth date and

the Button will be used to open a pop-up window. Configure these widgets as identified in
Table 4.3 and Table 4.4.

Table 4.3 Attribute Values of Email Widgets

Widget Email Text Email Edit
Attribute

+id textEMail editEMail
Text E-Mail Address: —
layout_width wrap_content wrap_content

layout_height wrap_content wrap_content
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Widget
layout_alignParentLeft
layout_marginLeft
layout_marginTop
layout_below

ems

inputType

Email Text
true

10dp

15dp
@+id/editHome

Email Edit
true

10dp
@+id/textEMail
13

textEmailAddress

Table 4.4 Attribute Values of Birthday Widgets

Widget Birthday Text Date Text Button
Attribute

+id textBday textBirthday btnBirthday
text Birthday: 01/01/1970 Change
layout_width wrap_content wrap_content wrap_content

layout_height
layout_alignParentLeft
layout_alignParentRight
layout_marginLeft
layout_marginRight
layout_marginTop
layout_below
layout_toRightOf
layout_alignBottom

paddingBottom

wrap_content

true

10dp

15dp
@-+id/editEMalil

25dp

wrap_content

@+id/textBday
@+id/textBday

25dp

wrap_content

true

10dp

@+id/textBirthday

The Change Birthday button uses several new attributes. The button should be anchored to
the right side of the screen so that its position doesn’t change as the birthday value changes.
To do this, you use the layout alignParentRight="true" attribute/value pair, and to make
it have a margin from the screen, you use the layout marginRight="10dp" attribute/value
pair. The birthday widgets are all on one line. To make this work, the layout_toRightOf and
layout_alignBottom attributes are used with the birthday date display Textview. However,
the button is aligned to the right of the screen with the attribute previously discussed. To make
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it line up with other widgets, a new attribute, IS CUCHaIIGHBESEINE, is used. This HEHSIAE

_ aligning it bottom to bottom would make it tall enough on the screen to
cover a portion of the email EditText. Finally, the paddingBottom="25dp" attribute/value
pair provides whitespace in the scrollview after the last widget. Without this, the birthday
widgets would be appear right above the navigation bar and the button would be partially
hidden by it. Test this yourself by executing the app on the emulator before you add the
padding attribute. To test on the emulator, you have to create a new Run Configuration like
you did for the Hello World app, except this one would use the MyContactList as the project.
If you are using the same workspace as you did for Chapter 3, “Using Eclipse for Android
Development,” you do not have to create a new virtual device. You can select the same device
as you did in that chapter. Remember that you also need to start the emulator. When the
layout is displayed on the emulator, click and hold on any whitespace in the layout and drag to
the top of the emulator screen. Try it again after you add the padding.

When the layout is complete, verify that it looks like Figure 4.9. Examine the bottom of the
figure closely. The scrollview was selected (surrounded by a thin blue line) before the screen-
shot was taken. Notice that the bottom blue line runs through the navigation bar. This is where
the bottom of the Change button would be if the paddingBottom attribute had not been
added. In other words, it would have been partially obscured by the navigation bar.

Congratulations! You have completed your first real layout in Android. However, there is one
more layout task to complete before writing code to make the layout do something—that is to
create a layout for the birthday selection dialog box.

Create the Dialog Layout

Although Android provides a DatePickerDialog class that provides the functionality needed,
you are going to create the dialog from scratch to learn how to create and use custom dialogs in
an app. The birthday selection date dialog is relatively simple. It displays a DatePicker widget,
which allows the user to select a specific date, and Cancel and OK buttons. Development of
this pop-up introduces the use of two new layouts, LinearLayout and TableLayout.

Begin by adding a new XML layout file to the project.
1. Right-click the layouts folder in the Package Explorer and select New > Other from the
pop-up menu.
2. Expand the Android folder in the window that opens, and double-click Android XML

Layout file. Enter dateselect as the name of this new layout.

3. Click Finish, and the new layout will open in the editor and dateselect.xml will be
displayed in the layout folder of the Package Explorer.

The wizard creates the layout file with a LinearLayout with a vertical orientation as its root
layout. This means that all widgets added will be stacked on top of the other. To see this, drag
a DatePicker object from the Time & Date folder in the Palette and then two small buttons.
Notice that whatever you do, they always end up one on top of another. This is not the best
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design for OK and Cancel buttons! This problem will be fixed by using a TableLayout. Leave
the DatePicker, but delete the two buttons. Then open the Layouts folder in the Palette and
drag a TableLayout to the editor, making sure it is positioned after the batePicker. The
layout is empty, but you can see where it is because it is highlighted with a thin blue rectangle.

% MyContactList

OFF Save
)y e =
Contacl;
Address;
Home Phone; Cell Phone; I

E-Mail Address;:

layout_alignBaseline Birthday: 01/01/1970 Change

Figure 4.9 Completed contact layout.

Note

Adding the DatePicker to the layout may cause an error screen to show up at the bottom of
the editor. You can ignore this. Although it says it can’t find the DatePicker class, it will at
runtime. This is a bug in some versions of Eclipse.

Examine the Outline. Notice that the TableLayout also contains some TableRows. If there is
more than one row, delete the extras by right-clicking them in the Outline and selecting Delete
from the pop-up menu. Drag two buttons to the remaining TableRow either on the editor or in
the Outline. Verify that they are in the proper position by looking at the Outline (Figure 4.10).
Switch to dateselect.xml to configure the widgets.


layout_alignBaseline

layout_alignBaseline
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B2 Outline 52 = g
4 [ LinearLayout
ZIEH datePickerl
4 [=] Tablelayout
4 = tableRowl
[oK) buttonl
[ox) button2

Figure 4.10 Outline after adding buttons.

The modifications to this XML are relatively simple as compared to the data entry form.

1.

Add an id attribute to the LinearLayout with the value @+id/dateSelectLayout. An
ID is needed for this layout to be able to tell the pop-up window what layout to display.

Change the ID of the DatePicker widget to @+id/birthdayPicker.

Add the following attribute to the DatePicker just after the id attribute: android:
calendarViewShown="false". Some versions of the Android OS will automatically show
a picker and a calendar if this line is not included.

Change the id’s and text attribute values for the first and second buttons to
@+id/btnCancel, Cancel and @+id/btnok, Ok, respectively.

Switch to Graphical Layout to view the results. Notice that the two buttons have

diffSrentisizes. PRisHsIaiproblemitonusability. It makes the interface look asymmetrical

and one button more difficult to select than the other.

Switch back to the XML and change the layout_ width attribute of both buttons from
wrap_content to 120dp.

. Switch back to Graphical Layout. If the buttons are the same size, your pop-up layout is

complete (Figure 4.11)!

% MyContactList

Cancel Ok

Figure 4.11 Completed pop-up layout.
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The patePicker widget will display only at runtime. However, you don’t write the code to
open the dialog until later in this chapter, so you will have to wait to test it. When you do run
the app you should see something like Figure 4.12 when you change the contact’s birthday.

r
& 5554MyTestDevice =

| %mﬁ 5:48 pm RIS

Hardware Buttans

Select Date

+ f + +

MayQ§ 31 §2013

L

Figure 4.12 DatePicker displayed in running app.

Activating the Interface

The primary function of the Contact activity is to save information about the user’s contacts.
The saving of data is beyond the scope of this chapter but is addressed in the next chapter.
However, other functions can be implemented at this time. This section demonstrates the
coding of the navigation bar, coding the toggle button to switch between editing and viewing
modes, coding the Change Birthday button to display the dialog window, and coding the
dialog.

Code the Navigation Bar

Movement and data transfer between activities is done with Intents as discussed earlier in
this chapter. The use of Intents makes coding navigation relatively simple. The Intent does
most of the work. Open the ContactActivity.java file in the src folder by double-clicking it.
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Activating the Interface

Begin by coding the List ImageButton. Enter the code in Listing 4.8 before the last } in the
ContactActivity.java file.

Listing 4.8 List Button Code

private void initListButton() {

ImageButton list = (ImageButton) findvViewById(R.id.imageButtonList) ; //1
list.setOnClickListener (new View.OnClickListener () { //2
public void onClick (View v) {
Intent intent = new Intent (ContactActivity.this, //3
wContactListActivity.class) ;
intent.setFlags (Intent. FLAGiACTIVITY;CLEARiTOP) ; //4

startActivity (intent) ;

Bk
}

When you enter the code, some of the objects may be underlined in red. This indicates that
the compiler doesn’t know what that object is. To fix this, rest your pointer on the underlined
object and select the Import statement from the list of hints that appear. If there is no Import
option, it is likely that you misspelled the object name. This code is used to associate the
ImageButton named imageButtonList on the activity contact layout with the code that
is executed when it is pressed.

1. A variable to hold an ImageButton is declared and findviewById gets the widget named
imageButtonList. FindViewById returns the widget as a generic object, so it must be
cast (ImageButton) to an ImageButton before it can be assigned to the variable.

2. A listener is added to the ImageButton. A listener makes a widget able to respond to
different events. In this case, the listener makes the ImageButton able to respond to the
user pressing it.

3. An Intent variable is declared and a new Intent is created and assigned to it. The intent
constructor requires a reference to its current activity (ContactActivity.this) and to
know what activity it should start (ContactListActivity.class).

4. An intent flag is set to tell the operating system to not make multiple copies of the same
activity.

The completed method name initListButton () is underlined in yellow. This indicates

that the method is never used. To use it, enter initListButton () ; after the setContent
(R.layout.activity contact) line of code in the onCreate method at the beginning of the
file. This code calls the button initiation code at creation of the activity so that it is ready for
use when the user sees the layout. The yellow line should disappear. Complete the navigation
bar code by copying the preceding code for each of the two remaining ImageButtons, and
make the following changes for the first new method:
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initListButton () to initMapButton ()
R.id.imageButtonList tO R.id.imageButtonMap

ContactListActivity.class to ContactMapActivity.class

Similar changes should be made to the second new method:
initListButton() to initSettingsButton ()
R.id.imageButtonList tO R.id.imageButtonSettings

ContactListActivity.class to ContactSettingsActivity.class

Be sure to call the new methods in the onCreate method. The navigation bar is now ready
for testing. Run the app on the emulator and test that each button opens the correct activity.
Because the navigation bar is not currently coded for these activities, you will have to use the
Back button to return to the ContactActivity.

Code the Toggle Button

Coding the toggle button is relatively easy, if not somewhat tedious. It is easy because you
need only to enable or disable the interface. It is tedious because each widget that the user
could interact with must be enabled or disabled separately. The ToggleButton's functionality
requires the creation of three methods. One method will initialize the button to respond to the
user. A second method will enable all the data entry widgets, and the third will disable all the
widgets. First enter the code in Listing 4.9 after the navigation bar button code to initialize the
ToggleButton. Remember to import any items underlined in red.

Listing 4.9 ToggleButton Initialization Method

private void initToggleButton() {

final ToggleButton editToggle = (ToggleButton)
wfindViewById(R.1id.toggleButtonEdit) ; //1

editToggle.setOnClickListener (new OnClickListener () {

@Override
public void onClick(View arg0) {
setForEditing (editToggle.isChecked()) ; //2

1
}

The code is very similar to the navigation button initialization methods. A reference to the
widget is grabbed and an onClickListener is added to the button. There are a few differences
that need some explanation.
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1. The final keyword is added to the statement that gets the reference to the
ToggleButton to prevent the variable assignment from changing. This is required
because it is being used in the button click code. It ensures that the widget referred to
cannot change, so the code is always working on the same thing.

2. The onClick method calls the setForEditing method, passing it true if the button is
toggled for editing and false if it is not.

The next step is to code the methods to do the enabling and disabling of the form. Enter the
code in Listing 4.10 to create the setToEditing () method.

Listing 4.10 Code to Enable the Data Entry Form

private void setForEditing(boolean enabled) {

EditText editName = (EditText) findViewById(R.id.editName) ;
EditText editAddress = (EditText) findViewById(R.id.editAddress) ;
EditText editCity = (EditText) findViewById(R.id.editCity);
EditText editState = (EditText) findviewById(R.id.editState);
EditText editZipCode = (EditText) findViewById(R.id.editZipcode) ;
EditText editPhone = (EditText) findViewById(R.id.editHome) ;
EditText editCell = (EditText) findViewById(R.id.editCell) ;
EditText editEmail = (EditText) findViewById(R.id.editEMail);
Button buttonChange = (Button) findViewById(R.id.btnBirthday) ;
Button buttonSave = (Button) findviewById(R.id.buttonSave) ;

editName.setEnabled (enabled) ;
editAddress.setEnabled (enabled) ;
editCity.setEnabled (enabled) ;
editState.setEnabled (enabled) ;
editZipCode.setEnabled (enabled) ;
editPhone.setEnabled (enabled) ;
editCell.setEnabled (enabled) ;
editEmail.setEnabled (enabled) ;
buttonChange.setEnabled (enabled) ;
buttonSave.setEnabled (enabled) ;

if (enabled) {
editName.requestFocus () ;

Add the following two lines of code to the onCreate method to initialize the ToggleButton
and set the screen so that it is not in editing mode when it opens:

initToggleButton() ;
setForEditing (false) ;
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Run the app to test the button. You may find one “error.” The Contact name field looks
disabled when the app opens, but it has focus and will allow data to be entered. Earlier versions
of the Android OS always want to put focus on an EditText and will do so on the first
EditText it finds in a layout. This is a relatively well-known bug/feature. There are a number
of hacks to get around it. For demonstration purposes, one such hack is included in the sidebar.
However, not every approach works or is reasonable for all circumstances. If you want to stop
the autofocus from occurring, you should do it on a case-by-case basis.

Hacking Autofocus of EditText

One approach to stopping the autofocus places a dummy layout in the root layout to grab the
focus. It is set to be focusable but has no size so it is not visible. This approach also clears
the focus from all widgets in the setForvViewing () method allowing the LinearLayout to
grab the focus. Enter the following XML as the first element after the root RelativeLayout in
the activity_contact.xml file.

<LinearLayout
android:focusable="true"
android:focusableInTouchMode="true"
android:layout_width="0px"
android:layout height="0px" />

Next, modify the if statement at the end of the setForview () method in the ContactActivity.
java file so that it looks like the following:

if (enabled) {
editName.requestFocus () ;
}
else {
Scrollview s = (Scrollview) findvViewById(R.id.scrollViewl);

s.clearFocus () ;

}

After you disable all the widgets, this code clears the focus from all of them so that the dummy
LinearLayout can grab it. If you enter this code, your app will now properly switch between
editing and viewing modes.

Code the DatePicker Dialog

The DatePicker dialog is a window that opens when the user presses the Change button. A
custom dialog requires both a layout, which you have already created, and a class that contains
the code that gives the dialog its behavior. Using a custom dialog in an activity also requires
changes to the activity code. The following describes how to code the DatePickerDialog class
and make changes to the ContactActivity to display and use the dialog.

The first task is to create a new class to hold the custom dialog code. Right-click com.
example.mycontactlist in the src folder and select New > Class from the pop-up menu. Enter
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DatePickerDialog for the Name and click Finish. The new class opens with a limited amount
of code. Replace all that code except the first line (package com.example.mycontactlist) with
the code in Listing 4.11.

Listing 4.11 DatePickerDialog Code

import android.os.Bundle;

import android.support.v4.app.DialogFragment;
import android.text.format.Time;

import android.view.LayoutInflater;

import android.view.View;

import android.view.ViewGroup;

import android.view.View.OnClickListener;
import android.widget.Button;

import android.widget.DatePicker;

public class DatePickerDialog extends DialogFragment { //1

public interface SaveDateListener { //2
void didFinishDatePickerDialog(Time selectedTime) ;

public DatePickerDialog() { //3
// Empty constructor required for DialogFragment

@Override

public View onCreateView(LayoutInflater inflater, ViewGroup container,
wRundle savedInstanceState) { //4

final View view = inflater.inflate(R.layout.dateselect, container);
getDialog() .setTitle("Select Date");

final DatePicker dp = (DatePicker)
wvyview.findviewById(R.1id.birthdayPicker) ;

Button saveButton = (Button) view.findViewById(R.id.btnOk) ;
saveButton.setOnClickListener (new OnClickListener() {
@0Override
public void onClick(View arg0) {
Time selectedTime = new Time() ; //5
selectedTime.set (dp.getDayOfMonth (), dp.getMonth(), dp.getYear());
saveltem(selectedTime) ;

D
Button cancelButton = (Button) view.findvViewById(R.id.btnCancel) ;
cancelButton.setOnClickListener (new OnClickListener () {
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@Override
public void onClick (View v) {
getDialog () .dismiss () ;

1

return view;

private void saveltem(Time selectedTime) { //6
SaveDatelistener activity = (SaveDatelistener) getActivity();
activity.didFinishDatePickerDialog (selectedTime) ;
getDialog () .dismiss () ;

}

A significant number of important concepts for Android app development are introduced in
this code. Fortunately, dialog coding follows the same pattern, so after you understand the
components, you can apply them whenever you need your app to show a dialog window.

1. The declaration of the class includes the keywords extends DialogFragment. This
makes the DatePickerDialog class a subclass of the DialogFragment, which in turn is
a subclass of the Fragment class discussed earlier in this chapter. All custom dialogs in an
Android app should be created in this way.

2. A listener must be created with the DialogFragment. This is how the dialog
communicates the user’s actions on the dialog back to the activity that displayed the
dialog. The listener must have a method to report the results of the dialog. The activity
will have to implement the listener to handle the user actions.

3. A constructor for the class is required. It almost always is empty.

4. This method is the workhorse of the class. It creates the View from the resources in the
layout file associated with it by the line inflater.inflate(...). The method also gets
references to the widgets on the layout and sets up listeners for the widgets in the layout
so that they can respond to user action.

5. Time objects are used to hold dates and times. This object stores a time/date as a number
of milliseconds (millis) from Jan. 1, 1970. A new time object is created, and when the
user clicks the OK button, it grabs the user selections on the DatePicker and sets the
time object to that time. Finally, it calls the saveItem method to report the selection to
the main activity.

6. The saveItem method gets a reference to the listener and calls its method to report the
results of the dialog.

Save the DatePickerDialog class. This pattern is always used with custom dialogs. Each dialog
needs a listener interface and associated method, a constructor, an onCreatevView method, and
a call to the listener method. The call to the listener method does not necessarily have to be in
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its own method as it is here. Finally, the dialog must be dismissed at the end of every code path
in the DialogFragment.

Before the dialog can be tested, it must be implemented in the activity that uses it. In this case
it is the ContactActivity. Switch to or open the ContactActivity.java class. The following
steps must be done in the exact order listed here, or potential problems may occur.

1. Locate the class declaration: public class ContactActivity extends Activity
and change Activity to FragmentActivity. This makes your ContactActivity a
subclass of the FragmentActivity discussed earlier in the chapter. This is required to use

DialogFragments

2. FragmentActivity will be underlined in red and a whole bunch of errors will
show up in the code. Hover your cursor over FragmentActivity and select Import
FragmentActivity (android.support.v4.app). The FragmentActivity class is in the
android.support.v4.app library, which is a set of code that provides objects to make some
features in newer Android operating systems work in older versions.

3. Add the words implements SaveDateListener after FragmentActivity so that the
class declaration is public class ContactActivity extends FragmentActivity
implements SaveDateListener {. After making the change, SaveDateListener will
be highlighted in red. Hover over it to get the pop-up menu and select Import.

4. ContactActivity becomes highlighted in red. Hover your cursor over it and select
Add Unimplemented Methods from the pop-up menu. When an activity implements a
listener, it must implement the methods associated with the listener so that the results
may be used in the activity.

5. Scroll down to the bottom of the ContactActivity.java file. You should find the following
code. If not, delete your changes and repeat the preceding steps.

@Ooverride
public void didFinishDatePickerDialog(Time selectedTime) {
// TODO Auto-generated method stub

}

The didFinishDatePickerDialog method is the code that will handle the date that the user
selected. Enter the following two lines of code in place of the ToDO line:

TextView birthDay = (TextView) findViewById(R.id.textBirthday) ;

birthDay.setText (DateFormat . format ("MM/dd/yyyy", selectedTime.toMillis(false)).
toString()) ;

Some of the code may be highlighted in red, indicating that it needs to be imported. In the
case of DateFormat you will see two import options. Choose android.text.format. This code
gets a reference to the TextView that will display the date and set its text attribute to a string
produced by the DateFormat . format method.

You are almost ready to test your dialog. The last thing to do is to code the Change button to
make it display the dialog. Add the code in Listing 4.12 to the ContactActivity.
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Listing 4.12 Change Birthday Button

private void initChangeDateButton() {
Button changeDate = (Button) findvViewById(R.id.btnBirthday) ;
changeDate.setOnClickListener (new OnClickListener () {

@Override

public void onClick (View v) {

FragmentManager fm = getSupportFragmentManager () ; //1
DatePickerDialog datePickerDialog = new DatePickerDialog() ; //2
datePickerDialog.show (fm, "DatePick"); //3

1

Most of the code is standard initialization of a button to respond to the user pressing the
button. The code to be executed when the click occurs displays the dialog.

1. A FragmentManager is a required object to manage any and all fragments displayed in
an activity. It needs to be imported. There will be two choices; again, choose the one
from the Android support library (android.support.v4.app).

2. A new instance of the DatePickerDialog class is created.

3. The DatePickerDialog's show method (inherited from DialogFragment) displays the
dialog. The method requires an instance of a FragmentManager and a name, which the
FragmentManager uses to keep track of the dialog.

Be sure to call the initChangeDateButton () method in the onCreate method of
ContactActivity. The app interface is ready to be tested! Run it to be sure that the dialog is
displayed and the correct date is placed in the Textview.

Summary

Creating layouts is a lot of work! In this chapter you learned how to use Eclipse to create an
Android layout file that is the user interface for an app activity. Development of a layout
requires use of both the graphical editor and modification of the associated XML to get the
exact design you want. Experimentation is often the key to getting the layout to look the way
you want it to.

Intents are used to switch between Activities and sometimes pass data to those
Activities. You learned how to use Intents to implement a navigation bar that allows the
user to move between different Activities in your app.

Finally, you learned how to use Fragments to implement a custom dialog window. You also
learned how to display the custom dialog and to communicate the results of the user interac-
tion with the dialog back to activity so that it could act on those actions.
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Exercises

1. Create a new color resource to be used as the background for the data entry part of
the ContactActivity. Search on the Web for the color and associated Android color
code (color codes always start with a # symbol) and add it to the color.xml file. Set the
background of the data entry part of the layout to that color resource.

2. Make the navigation work for all activities in the app. Copy the navigation bar XML code
to the layout associated with each activity. Copy the Java code that makes the buttons
work to the Java file associated with each activity. You will have to modify that code
to reference the activity it is in rather than ContactActivity. Add code to disable the
ImageButton associated with the activity that is displayed.

3. Modify the DatePickerDialog layout so that the Cancel/OK buttons are centered. Hint:
You'll have to use the gravity attribute in the TableRow.

4. Add the hack to your code to stop the autofocus of the EditTexts.
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Persistent Data in Android

The capability to have data that the app uses or relies on to continue to be available regardless of
changes to the app’s state as it moves through the app life cycle is vital to the user experience with the
app—and for the app itself to be a useful tool. For this to occur, the data needs to persist through these
life cycle changes. Android provides several ways in which the developer can make data persist. This
chapter introduces you to three of these data persistence approaches. A significant amount of time will
be spent on understanding and using the SQLite database system incorporated with Android, but the
chapter also discusses storing data in files and demonstrates how to store individual pieces of data in
an object that persists across an app’s life cycle.

Preferences, Files, and Database

The three approaches to data persistence discussed in this chapter ar1z SharedPreferences,
standard flat file input/output, and tlr9 SQLite database system. Each of these approaches
provides capabilities that are relevant for different tasks in an app.

They may also be used for other data that needs to persist across life cycle changes.

Flat fles are useful for backing up data and transmitting to other users. Inally, databases are
eSO HOSE o A AA RIS HORMOTEENAMANERHENaL. Do\ cloping an understanding of

where, when, and how to use these data persistence approaches is very important to effective
development of an Android app.

Preferences

Preferences are implemented through use of the sharedpreferences class. A
SharedPreferences object can be used to store primitive data (for example, integers and
strings) in a key/value pair. Each value has its own key for storage and retrieval of that data.
SharedPreferences are stored in memory private to the app and will persist as long as the
app remains installed on the device. App upgrades will not impact the values stored with

SharedPreferences.
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There are two main modes for accessing SharedPreferences: getSharedPreferences
("String preference name", integer mode) and getPreferences (integer mode). The
getSharedPreferences mode is used when you want to have more than one set of prefer-

ences for an app, or you want the preferences available to any Activity in the app. Fach set
is given a name that is used as the key to access that particular set of preferences.

BEEBTEEETENEEE method. With each of these methods you need to set an access mode. Using
0/(zer0) miakes the preferences private to/theapp. Preferences may also be given a mode that

makes them readable or writeable from outside the app. However, this is discouraged because it
opens potential security holes. Data is stored by using a method appropriate to the value being
saved (for example, putBoolean or putInt) and supplying a string that will be the key for
future access to that value. Likewise, data is retrieved from the object using the string key with
the appropriate get method (for example, getBoolean or getInt). Specific implementation of
the sharedpPreferences method of data persistence will be explained later in this chapter.

Files

FileslareRvitteniandireadiasialstieanioribytes. This means that to the Android system, a file is

one thing. It does not have parts, such as different objects, within it. The advantage to this is

that the
Thus, many kinds of data can be stored in a file. The HiSAUVANAGE is that it
is iGN EIopeeIco e eadinE RNV ENEIONREHNINE so that the data can be used

appropriately when it is needed. For example, the developer can embed XML in the stream to
identify the different types of data. Another approach is to embed commas in the file to distin-
guish different pieces of data. However, in either case, the user of that file must know its struc-
ture to use it correctly.

Files can be written to either internal or external storage. Files written to internal storage are
private to the app. They will persist as long as the app is installed on the device. [Filés written
Al SRR SUCHES RIS DICA) IS HOUDHVAISNONRRERD Other apps can access them
and if the device is connected to a computer, they are accessible (including being able to
modify and delete) to the user of the computer. Files are written and read from storage using
the FileOutputStream and FileInputStream objects in a similar fashion to any regular Java
program. Although files can be very useful persistence tools, they will not be discussed further
in this book.

Database

Android supports the use of SQLite databases.
It does not require

an independent server process to execute. A relational database system allows the developer

to give meaning to the data stored within it by separating the data into tables (for example,

a customer table and an order table. Each table will hold data pertinent for each instance of
whatever is stored in the table (for example, data for each customer). SQLite also provides
capabilities for retrieval and manipulation of the stored data through the use of queries written
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Creating the Database

in Structured Query Language (SQL). Almost any type of data can be stored and manipulated
using a SQLite database, although some data types have more limited support than
other RDBMSs.

_ An app may create and use multiple databases, and each database can

have many tables, making data storage via SQLite both extensive and flexible. Databases are the
workhorse data storage of many apps and are discussed extensively in this chapter.

Android Versus i0OS: Data Persistence

Android and iOS offer essentially the same three types of data persistence mechanisms
discussed in this chapter. The functionality provided by SharedPreferences in Android is
provided by the NSUserDefaults object in iOS. File input and output is also provided in iOS.
Finally, i0S also implements SQBEI0atabases in a very similar manner to Android. i0S does
offer a storage solution called EOfelData that offers an object-oriented approach to storing
data, but this is usually added on top of a SQLite database. Although in all cases the code has
different commands because the programming languages are different, the functionality is the
same, so porting data persistence between platforms requires work. However, the concepts are
easily replicated.

Creating the Database

The MyContactList app uses a simple, one table database to provide the data storage and
manipulation functionality described in Chapter 2, “App Design Issues and Considerations.”
Two new classes will be created to provide the database functionality. One class is used to
create, moditfy, and delete the tables included in the database. The other class is used for
data access. It provides methods to open and close the database and the queries used to
store, access, and manipulate the data in the tables. The focus in this chapter is to make the
ContactActivity able to store a contact’s data. Retrieval and manipulation of that data is
introduced in later chapters.

Create the Database Helper Class

The recommended approach to using SQLite in an Android app is to create a Database Helper
class whose only function is to provide for the creation, modification, and deletion of tables in
the database. The new class is defined as a subclass of the sQLiteOpenHelper class. Much of
the required functionality for working with databases is inherited from the SQLiteOpenHelper
class although some of its methods will be overridden to implement the functionality required
for this app.

1. Right-click com.example.mycontactlist in the src folder of the Package Explorer.

2. Select New > Class and enter ContactDBHelper as the name of the new class.
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3. Type the code in Listing 5.1 into the new class. You will have to import many of the
objects after you have entered the code.

Listing 5.1 Code for the Database Helper Class

import android.content.Context;

import android.database.sqglite.SQLiteDatabase;
import android.database.sglite.SQLiteOpenHelper;
import android.util.Log;

public class ContactDBHelper extends SQLiteOpenHelper {

private static final String DATABASE NAME = '"mycontacts.db";
private static final int DATABASE VERSION = 1;

// Database creation sql statement

private static final String CREATE TABLE CONTACT = "create table contact (_id
winteger primary key autoincrement, "

+ "contactname text not null, streetaddress text, "
+ "city text, state text, zipcode text, "

+ "phonenumber text, cellnumber text, "

+ "email text, birthday text);";

public ContactDBHelper (Context context) {
super (context, DATABASE NAME, null, DATABASEfVERSION);

@Override
public void onCreate (SQLiteDatabase database) {
database.execSQL (CREATE TABLE CONTACT) ;

@0verride

public void onUpgrade (SQLiteDatabase db, int oldVersion, int newVersion) {
wI0g.w(ContactDBHelper.class.getName (),

"Upgrading database from version " + oldVersion + " to "
+ newVersion + ", which will destroy all old data");
db.execSQL ("DROP TABLE IF EXISTS contact");
onCreate (db) ;

//1

//2
//3

//5

/17

The previous code is relatively standard and all that is needed to create the SQLite database and

the one table required for the MyContactList app. The code can be copied and modified for
other apps. The code and its potential modifications are described next:
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1. The class ContactDBHelper is declared as a subclass of SQLiteOpenHelper. Most of its
functionality is inherited from this class.

2. A static variable is declared to name the database. A database name is required. Use the
.db extension.

3. A static variable to hold the database version number is declared and initialized to 1. This
variable is important. Every time the database is accessed, the existing database version is
compared to the one here. If the number is higher, the onUpgrade method is executed.

4. A string variable is declared and assigned to a SQL command that creates the table. It is
good practice to define the table definitions in this manner so that when a change to
a table needs to be made, all you have to do is change the definition in one place and
increment the version number. Declare a similar variable for each table needed in your
database.

5. The constructor method calls the super class’s constructor method. Nothing else needs to
be done in this method. The constructor creates a new instance of ContactDBHelper.

6. The onCreate method is called the first time the database is opened. If the database
named in the DATABASE_NAME variable does not exist, this method is executed. The
method executes the SQL assigned to the CREATE_TABLE_CONTACT variable.

7. The onUpgrade method is executed when the database is opened and the current version
number in the code is higher than the version number of the current database. This
method fifStldeletes the contact FBIE and CHlexecutesIncloncraate method to create
a new version of the table. Carefully planning the data needed by your app is important
so that you don’t have to use this method much. What happens in this method is
entirely up to the developer. Care must be taken because if a table is dropped, all the
user data currently in the table is lost. If you need to add columns to the table, consider
executing an ALTER TABLE SOL command rather than a drop, and re-create the table.

The Log command writes a message to the LogCat, which is a system for collecting and
viewing system debug information. You can view LogCat by selecting Window > Show
View > Other... > LogCat. This command may be eliminated if you want.

A database helper class is recommended practice in Android. The primary function of the class
is to determine what must be done on creation of the database and what must be done when
the database is upgraded. The next step is to create a class that does the opening and closing of
the database and contains the queries used to store and retrieve data from the database.

Create the Data Source Class

Create a new class named ContactDataSource. Enter the code in Listing 5.2, being sure to
import any objects underlined in red.
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Listing 5.2 contactDataSource Required Code

public class ContactDataSource {

private SQLiteDatabase database; //1
private ContactDBHelper dbHelper;

public ContactDataSource (Context context) { //2

dbHelper = new ContactDBHelper (context) ;

public void open() throws SQLException { //3
database = dbHelper.getWritableDatabase() ;

public void close() { //4
dbHelper.close() ;

The required methods are quite limited and fairly self-explanatory.

1. Variables are declared to hold instances of the SQLite database and the helper class. You
will get a warning on the sQLiteDatabase line because you don’t use it yet.

2. The helper class is instantiated when the data source class is instantiated.

3-4. Open and close methods are used to access and end access to the database.

The rest of the code in this class is dependent on the needs of the app. In the case of the
MyContactsList app, the ContactActivity needs to be able to insert new contacts and update
data for existing contacts. This is done by creating a method for each operation. The data for
insertion or updating a contact is passed to these methods with a Contact object.

The contact class does not exist, so the first task is to create that class. Create another new
class in the src folder named Contact. Enter the code in Listing 5.3 to create the Contact
object. The ContactActivity uses this object to store data entered by the user and pass it

to the data source class. Enter the code in Listing 5.3 to create the Contact class. Import any
needed classes. Note that two time classes are listed when you rest your pointer on the under-
lined Time. Use the android.text.format Time class.

Listing 5.3 The contact Class

import android.text.format.Time;

public class Contact {
private int contactID;
private String contactName;



private
private
private
private
private
private
private
private

String
String
String
String
String
String
String

streetAddress;
city;

state;
zipCode;
phoneNumber ;
cellNumber;
eMail;

Time birthday;

public Contact () {
contactID = -1;

public

public

public

public

public

public

public

public

public

public

Time t

= new Time () ;

t.setToNow () ;
birthday = t;

int getContactID() {
return contactID;

void setContactID(int i) {

contactID = i;

String getContactName () {

return contactName;

void setContactName (String s) {

contactName = s;

Time getBirthday() {
return birthday;

void setBirthday(Time t) {

birthday = t;

String getStreetAddress() {

return streetAddress;

void setStreetAddress(String s) {

streetAddress = s;

String getCity() {

return city;

void setCity(String s) {

city =

Sj
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public String getState() {
return state;

public void setState(String s) {
state = s;

public String getZipCode() {
return zipCode;

public void setZipCode (String s) {
zipCode = s;

public void setPhoneNumber (String s) {
phoneNumber = s;

public String getPhoneNumber () {
return phoneNumber;

public void setCellNumber (String s) {
cellNumber = s;

public String getCellNumber () {
return cellNumber;

public void setEMail (String s) {
eMail = s;

public String getEMail() {
return eMail;

The Ccontact class is a very simple class. It declares variables for each piece of data needed for

a contact and declares a method to set the value of the variable and a method to get the value
of the variable (getters and setter). The only really important code is in the class constructor
method. Notice that in this method the contact’s ID is set to -1. This is used by the app to
determine if the contact is new and needs to be inserted or the contact already exists and needs
to be updated. The birthday variable is also initialized to the current date. This allows the app
to assume that there will always be a Time value in the birthday variable.

After the Contact class has been created, you can now code the insert and update methods in
the ContactDataSource class. Enter the code in Listing 5.4 to create these methods. Enter the
code after the close () method.
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Listing 5.4 Insert and Update Contact Methods

public boolean insertContact (Contact c¢) {
boolean didSucceed = false;

try {
ContentValues initialValues = new ContentValues() ;

initialvalues.put ("contactname", c.getContactName ());
initialValues.put ("streetaddress", c.getStreetAddress());
initialvalues.put ("city", c.getCity());

initialvalues.put ("state", c.getState());

(
(
(
(
initialvalues.put ("zipcode", c.getZipCode()) ;
initialValues.put ("phonenumber", c.getPhoneNumber ()) ;
initialvalues.put ("cellnumber", c.getCellNumber()) ;
initialvalues.put ("email", c.getEMail());
(

initialvalues.put ("birthday",
wString.valueOf (c.getBirthday () .toMillis (false))) ;

didSucceed = database.insert ("contact", null, initialvValues) > 0;
catch (Exception e) {
//Do nothing -will return false if there is an exception

}

return didSucceed;

public boolean updateContact (Contact c) {
boolean didSucceed = false;
try {
Long rowId = Long.valueOf(c.getContactID());
ContentValues updateValues = new ContentValues();

updateValues.put ("contactname", c.getContactName()) ;
updateValues.put ("streetaddress", c.getStreetAddress());
updateValues.put ("city", c.getCity());

updateValues.put ("state", c.getState());
updateValues.put ("zipcode", c.getZipCode()) ;
updateValues.put ("phonenumber", c.getPhoneNumber ());
updateValues.put ("cellnumber", c.getCellNumber());
updateValues.put ("email", c.getEMail());

updateValues.put ("birthday",
wString.valueOf (c.getBirthday () .toMillis (false)));

didSucceed = database.update("contact", updateValues, " id=" + rowId,
wnull) > 0;

/74

//5

/17
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catch (Exception e)
//Do nothing -will return false if there is an exception

}

return didSucceed;

The two methods are very similar. The primary difference is that the updateContact method
uses the Contact ID to overwrite values in the Contact table, whereas the insertContact
method just inserts contact data and the database inserts the ID because the id field was
declared as an autoincrement field.

1. A Boolean variable is declared and assigned the value false. Both the update and insert
methods return a Boolean to tell the calling code if the operation succeeded. The value is
initially set to false and then changed to true only if the operation succeeds.

2. The ContentValues object is used to store a set of key/value pairs that are used to assign
contact data to the correct field in the table.

3. The values for the table are retrieved from the Contact object, associated with the
correct field, and inserted into the Contentvalues object. Note that the date is stored as
millis, because SQLite doesn’t support storing data as dates directly.

4. The database’s insert method is called and passed the name of the table and values to
insert. The method FeflifnS the Number of fecords (E6ws) Stccessfully inserted. The value
is compared to zero. If it is greater than zero, then the operation succeeded and the
return value is set to true.

5. If the method throws an exception, the return value is already set to false, so we don’t
have to do anything.

6. The update procedure needs the contact’s ID to correctly update the table. This value is
retrieved from the Contact object and assigned to the variable rowId.

7. The database’s Hpdate method is called to place the changes in the database. Just like the

insert method, if the operation is a success, the method_

- If this number is greater than zero, the operation was successful.

The SQLite database is ready for use. An object to create and upgrade the database has been
implemented. Another object to open, close, and access the database has also been created. You
are now ready to save contact data!

Using the Database

The three classes, Contact, ContactDBHelper, and ContactDataSource, are used in the
ContactActivity class to implement the saving of contact data to the database. This will
require implementing several new methods and modifying some existing methods. Because the
methods to retrieve contacts have not been implemented yet, the update functionality will be
only partially implemented at this time.
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The first step is to provide an association between the ContactActivity class and a Contact
object. This is implemented by declaring a private variable in the ContactActivity class. Enter
the following code after the class declaration and before the onCreate method:

private Contact currentContact;

Next associate the currentContact variable with a new Contact object by entering the follow-
ing code as the last line in the onCreate method:

currentContact = new Contact () ;

Notice that while you are using a new object (Contact) in the ContactaActivity class, you
do not have to import it. That’s because you created the Contact class as a part of the com.
example.mycontactlist package. Android already knows about this class, so it does not have to
be imported.

The final step in modifying existing code is to add a line of code in the
didFinishDatePickerDialog method to store the selected birthday in the Contact object.
Add the following line of code as the last line of code in that method:

currentContact.setBirthday (selectedTime) ;

This code uses the Contact class’s setBirthday method to assign the date selected in the
custom dialog to the currentContact object.

Capture User-Entered Data

The first new method needed is used to capture the user data as it’s typed and store it in the
currentContact object. The method itself does not capture the data. Rather, it sets up listeners
on all the EditTexts where data can be entered. If the text changes, the listener then executes
the code to set the attribute that holds the code in the currentContact object. The method is
called in the onCreate method of the contactActivity so that the listeners are ready to go
when the ContactActivity is ready for input. To start, enter the following line of code after
all the other init methods in the onCreate method:

initTextChangedEvents () ;

Next, create a new method in the ContactActivity class called initTextChangedEvents ().
Place this method after the other init methods currently in the class. Enter the code in
Listing 5.5.

Listing 5.5 TextChanged Event Code

private void initTextChangedEvents () {

final EditText contactName = (EditText) findViewById(R.id.editName) ; //1
contactName . EUGTERECHaNGEANISTEHeE (new FEREWSEOHSE () { /12
public void afterTextChanged (Editable s) { //3

currentContact.setContactName (contactName.getText () .toString()) ; //4

99


Hamid

Hamid


100 Chapter 5 Persistent Data in Android

}

public void beforeTextChanged (CharSequence arg0, int argl,
wint arg2, int arg3l) { //5
// Auto-generated method stub

}

public void onTextChanged (CharSequence s, int start, int before,
wint count) { //6

// Auto-generated method stub

1

final EditText streetAddress = (EditText) findViewById(R.id.editAddress) ; //7
streetAddress . ldTeKECHanGeaISEenes (nev FEXENaTCRes () {
public void afterTextChanged (Editable s) {
currentContact.setStreetAddress (streetAddress.getText () .toString()) ; //8

}

public void beforeTextChanged (CharSequence arg0, int argl,
wint arg2, int arg3) ({

// RAuto-generated method stub

}

public void onTextChanged (CharSequence s, int start, int before,
wint count) {

// RAuto-generated method stub

1N

Listing 5.5 is not the complete method. A listener has to be added for all the other EditTexts
in the layout. However, the code is essentially the same for each EditText. Take time to under-
stand this code before adding the rest.

1. A reference to the Contact Name EditText is assigned to the variable contactName. The
variable is declared as final because it is used inside the event code.

2. A TextChangedListener is added to the EditText by creating a new TextWatcher

object. eI TERENaECHERObjectequies TRattAfeSMEhods (lines 3, 5, and ©) are

implemented, even though you will use only one of these events.

3. The @fterTextChanged method is a required method for the Textwatch object. It is

called after the user completes editing the data and leaves the EditText. This is the

event that this app uses to capture the data the user entered.

4. This code is executed when the user ends editing of the EditText. It gets the text
in the EditText, converts it to a string, and sets the contactName attribute of the
currentContact object to that value.

5. The beforeTextChanged method is a required TextWatcher method. This method is
executed when the user presses down on a key to enter it into an EditText but before
the value in the EditText is actually changed.



Hamid

Hamid

Hamid

Hamid

Hamid

Hamid

Hamid

Hamid

Hamid


Using the Database

6. The GHTextcHanged method is also a required TextWatcher method. The method is

7. The pattern repeats for another EditText in the layout, except that value is assigned to a
different attribute of the currentContact object.

8. This code gets the value entered into the editAddress EditText, converts it to a string,
and sets the streetAddress attribute of the currentContact object to that value. It
is essentially the same as the code in number 4, except that it gets the value from a
different widget and assigns it to a different attribute.

This code needs to be repeated for the remaining EditTexts in the activity_contact.xml file.
This includes the remaining address EditTexts, the phone and cell number EditTexts, and
the email EditText. You can copy and paste the code you already entered or type it. In either
case, but especially with the copy/paste approach, make sure you get a reference to the correct
widget (R.id.widget+id) and assign the value to the correct Contact attribute.

The next step in coding the initTextChangedEvents method is to set the phone number
EditTexts to autoformat the number as it’s typed. Enter the following code as the last code in
that method:

homephonevariable.addTextChangedListener (new PhoneNumberFormattingTextWatcher()) ;
cellphonevariable.addTextChangedListener (new PhoneNumberFormattingTextWatcher());

This code adds a listener to the phone number EditTexts that calls the
PhoneNumberFormattingTextWatcher object, which in turn adds the appropriate formatting
as the user types.

The final step is to add initTextChangedEvents () ; to the onCreate method to set up the
listeners when the activity is opened.

Save User-Entered Data

The intTextChangedEvents method you just created sets the stage for saving the contact’s
data. It sets the EditTexts to update the ContactActivity’s contact object with any changes
users make as they make them. All that is left is to pass that object to the insert or update
method in the ContactDataSource class so that the changes can be stored in the database.
This requires the addition of a method that initializes the Save button and executes the code
that will do the save operation when the button is pressed.

The initialization of the Save button is similar to the initialization of all the other buttons you
have coded so far. The only difference is what happens when the button is pressed. Enter the
code in Listing 5.6 before the initTextChangedEvents method you just created. Don’t forget
to call the method in the onCreate method where the rest of the button initialization methods
are called.
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Listing 5.6 Save Button Code

private void initSaveButton() {
Button saveButton = (Button) findvViewById(R.id.buttonSave);
saveButton.setOnClickListener (new View.OnClickListener () {

@Override

public void onClick (View v) {

ContactDataSource ds = new ContactDEEBSOURGE (ContactActivity.this); //1
ds.open () ; //2
boolean wasSuccessful = false; //3
if (currentContact.getContactID()==-1) { //4

wasSuccessful = ds.[IBERECONEAGE (currentContact) ;

else {
wasSuccessful = ds.lP0aEECONEaGE (currentContact) ;
}
ds . EI88E () ; //5
if (wasSuccessful) { //6

ToggleButton editToggle = (ToggleButton)
wfindViewById(R.1id.toggleButtonEdit) ;

editToggle.toggle () ;
setForViewing () ;

1

The only new code in this method is the code associated with the save operation. The basic
save operation opens the database, checks if this is a new contact to be inserted or if it should
be updated, and if the save was successful, to change the screen back to view rather than
editing mode.

1. A new ContactDataSource object is instantiated.

2. The database is opened. It is good practice to open the database just prior to using it and
close it as soon as you are done.

3. A Boolean variable is declared and set to false. This variable captures the return value of
the ContactDataSource methods and is used to determine the operations that should
be performed upon success or failure of the method.

4. The currentContact’s id is compared to -1. Only new contacts will have a -1 value. If it
is a new contact, the insertContact method is called and passed the currentContact
object. Otherwise, the updateContact method is called to save the new data.
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5. [THeldatabaselisiclosediasisooniasipossible. Do not forget to close the database! If you do

not close it, strange errors can show up during execution.

6. The return value is checked. If the save operation was successful, the ToggleButton is
toggled to viewing mode, and the screen is set for viewing. If it was not successtul, the
activity remains in editing mode.

Test the code on the emulator. You may notice one discrepancy. When you push the Save
button and the screen changes to viewing rather than editing mode, the keyboard remains
displayed if you didn’t dismiss it with the Back button. If you don’t have this happen, edit your
Android Virtual Device. Look for Hardware Keyboard Present and uncheck it. Stop and restart
the emulator. Many Android devices do not have a hardware keyboard, and if your app keeps
the soft keyboard displayed when the user is clearly done, it will make the user think that the
app doesn’t work properly.

Correct this by adding a method that dismisses the keyboard that is called when the Save
button is pressed. The code in Listing 5.7 is a partial method to do this. Place this method
before the didFinishDatePickerDialog method.

Listing 5.7 Partial hideKeyboard () Method

private void hideKeyboard() {

InputMethodManager imm =
= (InputMethodManager)getSystemService (Context . INPUT METHOD SERVICE) ;

EditText editName = (EditText) findViewById(R.id.editName) ;
imm.hideSoftInputFromWindow (editName.getWindowToken(), 0);
EditText editAddress = (EditText) findViewById(R.id.editAddress);
imm.hideSoftInputFromWindow (editAddress.getWindowToken (), 0);

Repeat the last two lines of code in Listing 5.7 for each EditText in the layout (changing
variable names and EditTexts). The first line gets a system service that manages user input.
The second line gets a reference to an EditText, and the third line closes the keyboard. Every
EditText must receive this treatment because there is no way of knowing which EditText
users were working with when they pressed the Save button. Add a call to this method in the
initSaveButton method just before the ContactDataSource is instantiated.

Test the modification in the emulator. Another discrepancy is exposed (again, only if you
have the hardware keyboard disabled in the AVD). The keyboard hides, but the screen remains
focused on the last EditText used. When the user saves the data and the screen displays in
view mode, it should be focused at the top of the screen. It does not do this. Fortunately,
there is an easy fix. Tell the Scrollview to focus on the top of the screen. Change the block
of code that requests focus for the contact name EditText in the setForEditing method to
the following to change the Scrollview’s focus to the top of the screen when switching to
viewing mode:
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if (enabled) {
editName.requestFocus () ;

}

else {
Scrollview s = (Scrollview) findViewById(R.id.scrollViewl);
s.fullScroll (ScrollView. FOCUS UP) ;

}

If you added the hack of the autofocus discussed in Chapter 4, “Android Navigation and
Interface Design,” you can add the second line of code just before the s.clearFocus () line.
The focus up must be before the clear focus. Otherwise it will override the clear, and autofocus
will again occur. Test the app again. Everything should work as expected.

One last problem exists with the ContactActivity. If the user adds a new contact, presses

the Save button, and then edits the data and presses Save again, another contact will be added
rather than updating the contact just entered. This is because the currentContact object

still has an ID of -1. There are a number of approaches to fixing this problem. You could

clear the screen and make users get the contact from the contact list (not yet implemented)

if they want to edit it. You could retrieve the newly inserted contact and reload the screen
with all the newly entered data and the id that was created by the auto increment of the ID
when the contact was inserted into the database. Or you could get the new ID and set the
currentContact ContactID attribute to that value. That is the approach used here. Open the
ContactDataSource and create a new method using the code in Listing 5.8.

Listing 5.8 Retrieve the New Contact ID

public int getLastContactId() {
int lastId = -1;

try {
String query = "Select MAX( id) from contact"; //1
Cursor cursor = database.rawQuery (query, null); //2
cursor.moveToFirst () ; //3
lastId = cursor.getInt (0); //4
cursor.close() ; //5

}

catch (Exception e)
lastId = -1;

}

return lastId;

Notice that the structure of this method is similar to the other insert and update methods.

A try and catch is used to handle an error if it occurs, and a value, set to failure initially, is
returned. However, because this is a method to retrieve data from the database rather than save
it to the database, there are some significant differences.
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1. An SQL query is written to get the maximum value for the _id field in the contact table.
The last contact entered will have the maximum value because the id field is set to
autoincrement.

2. A cursor is declared and assigned to hold the results of the execution of the query. A
cursor is an object that is used to hold and move through the results of a query.

3. The cursor is told to move to the first record in the returned data.

4. The maximum ID is retrieved from the recordset. Fields in the recordset are indexed
starting at 0.

5. The cursor is closed. Just like with closing the database, it is best to close the cursor as
soon as you are done using it. Forgetting to do so can lead to errors during execution.

Save the ContactDataSource.java file and open the ContactActivity code. Navigate to the
initSaveButton method. Enter the following code after the line of code that inserts a new
contact (not the update):

int newld = ds.getLastContactId();
currentContact.setContactID (newlId) ;

The first line uses the newly created retrieval method to get the newly inserted contact’s ID.
The second line sets the currentContact object’s ID to the retrieved value.

Use the Debugger

The ContactActivity is finished for now. However, it is difficult to test the recently added
functionality because currently it does not retrieve contact data. Therefore, to test that the
functionality you just added is working properly you have to watch it run. This is done using
the debugger.

The first step in using the debugger is to set a breakpoint. A breakpoint tells the debugger to
halt execution at that line of code. This gives you the capability to inspect the values in the
variables and step through the code line by line. There are two ways to set a breakpoint. The
first is to double-click the light gray vertical bar to the left of the code. This will put a blue dot
that represents the breakpoint in the bar (Figure 5.1). This method is quick but can cause prob-
lems because if you are not completely on the vertical bar, it will collapse the method that the
line of code is in. This isn’t really a problem because you can just expand it again, but it can
be frustrating. The second method is to right-click the vertical bar and select Toggle Breakpoint
from the pop-up menu. If you are in the wrong location you will not get that menu option.

To check whether the currentContact is getting a new ID, set a breakpoint in the
initSaveButton method on the hideKeyboard () line (Figure 5.1). When you run the
program, execution will halt at this line. After the breakpoint is set, run the app using the
emulator and the Debug Configuration you set up for the app. Fill in some values and press
the Save button. The Confirm Perspective Switch window opens, telling you that you need to
open the Debug Perspective. Click Yes. In the bottom left of the Debug Perspective, you will see
the app code with the hideKeyboard () line highlighted. The app has halted on that line and
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is waiting for your command. To control execution during debugging, use the Debug toolbar
buttons at the top of the perspective (See Figure 5.2). Different versions of Eclipse have these
buttons in different locations and order at the top of the perspective, so you'll have to look
for them.

= privale void inilSaveBullun{) {
Button saveButton = (Button) TindviewById(R.1d.buttonsave);
= savebutton.setUnLlickListener(new View.UnLlickListener() {

= [@verride
o public void onClick(View v) {
s « hideKeyboard():
ContactNataSource d= = new ContactDataSource(ContactActivity thic);
ds.open();

bowlean wasSuccesslul = 'f:n[].::;

if (currentContact.getContactID()==-1) {
washuccessful = ds.insertlontact(currentiontact);
int newId = ds.getlastContactId();
currentContact.setContactID(newId);

else {

wasSucrcessful = de_updateContact(rurrentContact);
1
ds.closc();

if (wassuccessful) {
loggletutton editloggle = (loggletutton) findviewbyld(K.id.togglebuttontdit);
editToggle.toggle();
setForViewing();
}
}
Bs

Figure 5.1 Code with breakpoint set.

‘.T:?.I 2| | 2| o3

Figure 5.2 Debug control buttons.

Hover over each of these to find the one that says Step Over. This advances the execution

by one line. Click this button and watch the code step line by line until you reach the
currentContact.setContactID (newId) line. Note that if your code doesn’t follow this path,
you've done something wrong and need to examine the code to see that it matches the code
in the previous listings. On the upper right of the perspective is a pane with two tabs: Variables
and Breakpoints (see Figure 5.3). Click the Variables tab if it is not already selected.

@)~ Variables 23 ©g Bicakpuinls

Figure 5.3 Variable inspection tab.
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In the Variables tab, find the newId variable and verify that its value is greater than -1. This
number may be significantly higher than -1 if you have run the app several times already. If

it is not greater than -1, review your code. Now step the code one more line and inspect the
currentContact variable. You may have to expand currentContact to see its attributes. If
you cannot find currentContact in the variables list, expand the variable named this, which
represents the whole activity, so it will have all the activity variables in it. Expand it until you
find currentContact. Check to see that the contact ID attribute is the same as the newId
value. If it is, you have successfully created an activity that can save data to a database!

The debugger can be stopped in several ways. The first would be to click the Terminate button
in the toolbar. The Terminate button is the one with the red square as an icon. The second is to
locate your debug configuration in the debug tab (typically in the top left of the perspective).
Right-click the configuration name and select Terminate from the menu.

An alternative to stepping through the code with the debugger is to use logging. With this
approach you place Log statements in your code in places where you’d like to know the value
of variables or that the method was executed. When your code executes, these statements
will be written to LogCat (see the discussion of Log statement and LogCat in the “Create the
Database Helper Class” section earlier in this chapter). This is a useful approach if you have to
run through a significant amount of code to get to the code you are interested in.

Using Preferences

SharedPreferences are an easy way to store bits of information that need to persist
over the life cycle of an app. In the MyContactList app, preferences are set in the
ContactSettingsActivity. This activity is developed so that you can learn how to use
SharedPreferences. To do so, the layout is first coded and then the Java file is edited.

Create the Settings Layout

Open the activity_contact_settings.xml file. If you have not already done so, add the naviga-
tion buttons to the layout. Do this by opening the activity_contact.xml file and copying the
RelativeLayout xml with the +id set to navbar to the activity_contact_settings.xml. Be sure
to include the end </RelativeLayout> tag. While in the XML view, delete the Textview XML
and delete the padding attributes in the root RelativeLayout. Switch to Graphical Layout

to verify that the navigation bar is visible and in the correct position. There should be no
whitespace around the navigation bar.

In Graphical Layout, drag two medium TextViews and two RadioGroup widgets from the
Form Widgets folder in the Palette to the layout. The RadioGroup widget looks like three circles
in a row. Positioning of these widgets should be similar to Figure 5.4.

Switch to activity contact_settings.xml and modify the XML to match Listing 5.9. Only
attributes that need to be added or modified are shown for each widget in the listing. Do not
change or modify any other attributes.
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% MyContactList

Medium Text
® RadioButton

F{adioBunur}

HadioBunor}
Medium Text
@ RadioButton

RadioButton

RadioBunon

Figure 5.4 ContactSettings layout loading widgets.

Listing 5.9 RadioButton and TextView XML
<TextView
android:layout marginLeft="15dp"
android:layout marginTop="15dp"
android:text="Sort Contact By:"
<RadioGroup
android:layout alignParentLeft="true"
android:layout marginLeft="35dp"
android:layout marginTop="10dp"



<RadioButton

android:id="@+id/radioName"

android:text="Name" />

<RadioButton

android:id="@+id/radioCity"

android:text="City" />

<RadioButton
android:id="@+id/radioBirthday"
android:text="Birthday" />

</RadioGroup>

<TextView

android:
android:
android:
android:

id="@+id/textView2"
layout _marginLeft="15dp"
layout_marginTop="15dp"
text="Sort Order:"

<RadioGroup

android:

android

layout marginLeft="35dp"
:layout_marginTop="10dp"

<RadioButton

android:id="@+id/radioAscending"

android:text="Ascending" />

<RadioButton

android:id="@+id/radioDescending"

android:text="Descending" />

</RadioGroup>

Using Preferences

After the modifications have been made, switch to Graphical Layout and verify that the layout
looks like Figure 5.5.

Code the

Page’s Behavior

The settings activity’s function is relatively simple. When a user presses one of the choices,
that value is stored as a key/value pair in SharedPreferences. When the page is accessed, the
activity reads the stored preferences and sets the RadioButtons to the stored value. The value
stored in a SharedPreferences is used in ContactListActivity to sort the list of saved contacts.
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% MyContactList

Sort Contact By:
® Name;
City
Birthday
Sort Order;

@ Ascending

Descending_

Figure 5.5 Completed ContactSettings layout.

Open the ContactSettingsActivity.java file and complete the following steps:

1. Copy the ImageButton initialization methods from the ContactActivity.java to the
ContactSettingsActivity.java file so that the navigation bar will work. These methods
are initMapButton (), initListButton(), and initSettingsButton (). Paste this
code before the last } in the ContactSettingsActivity.java file.

2. When the code is pasted into the ContactSettingActivity class, it will produce
errors. That is because the current activity in the Intent code is referencing the
ContactActivity. Change this for each to be the ContactSettingActivity (some
versions of Eclipse may do this for you).

3. Change the code in the initSettingsButton () method so that the button is disabled.
Use the following code:

private void initSettingsButton() {

ImageButton settings = (ImageButton) findviewById(R.
wid.imageButtonSettings) ;

list.setEnabled(false);

4. Call the three methods in the onCreate method.



Using Preferences

After you have completed coding the navigation bar, you have to code the activity so that it
displays the current preference. Create a method called initSettings and refer to the code in
Listing 5.10 to get it to properly configure the activity at startup.

Listing 5.10 Code to Initialize the Activity

private void initSettings() {
String sortBy = getSharedPreferences("MyContactListPreferences",
wContext.MODE PRIVATE) .getString("sortfield","contactname"); //1

String sortOrder = getSharedPreferences ("MyContactListPreferences",
wContext.MODE PRIVATE) .getString("sortorder", "ASC") ;

RadioButton rbName = (RadioButton) findViewById(R.id.radioName) ; //2
RadioButton rbCity = (RadioButton) findViewById(R.id.radioCity);
RadioButton rbBirthDay = (RadioButton) findViewById(R.id.radioBirthday) ;
if (sortBy.equalsIgnoreCase ("contactname")) { //3
rbName . setChecked (true) ;
}
else if (sortBy.equalsIgnoreCase("city")) {
rbCity.setChecked (true) ;
}
else {
rbBirthDay.setChecked (true) ;

RadioButton rbAscending = (RadioButton) findViewById(R.id.radioAscending) ; //4
RadioButton rbDescending = (RadioButton) findViewById(R.id.radioDescending) ;
if (sortOrder.equalsIgnoreCase ("ASC")) {

rbAscending.setChecked (true) ;

}

else {
rbDescending.setChecked (true) ;

The initSettings method gets the values stored in SharedPreferences to set the
RadioButtons to the value that the user checks.

1. A string variable is declared, and the value for the field to sort contacts by is
retrieved from SharedPreferences. The getPreferences method is used to
get the sharedPreferences object because there is no need to have multiple
SharedPreferences objects in this app. The sharedpreference file is opened as a
private object. The getString method is called on the SharedPreference object to
retrieve the string value associated with the sortfield key. If there is no value stored for
that key, the default value of contactname is assigned to the variable. The next line does
the same thing for the preferred sort order.

111



112  Chapter 5 Persistent Data in Android

2. A reference to each radio button in the sort field RadioGroup is assigned to a variable.

3. The value retrieved for the preferred sort field is evaluated to determine which
RadioButton should be set as checked.

4. The same operations are performed to set the sort order to the order preferred by the
user.

The next step is to create a method to store the selected user preference for each option. Two
methods are required, one for each RadioGroup. When the user presses a RadioButton in one of
the groups, which RadioButton pressed is determined and then the value associated with that
RadioButton is saved in SharedPreferences. Refer to Listing 5.11 for the code for these methods.

Listing 5.11 RadioButton Click Code

private void initSortByClick() {
RadioGroup rgSortBy = (RadioGroup) findViewById(R.id.radioGroupl) ;
rgSortBy.setOnCheckedChangeListener (new OnCheckedChangeListener () {

@Ooverride

public void onCheckedChanged (RadioGroup arg0, int argl)
RadioButton rbName = (RadioButton) findvViewById(R.id.radioName) ;
RadioButton rbCity = (RadioButton) findViewById(R.id.radioCity);
if (rbName.isChecked()) {

getSharedPreferences ("MyContactListPreferences",
= MODE PRIVATE) .edit ()
w putStr